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MYOB RetailEnterprise Licence Agreement

IMPORTANT - SOFTWARE LICENCE AGREEMENT, READ THIS AGREEMENT CAREFULLY. This Software Licence Agreement 
defines the terms of sale and use of the MYOB RetailEnterprise software and related User Guide and explanatory materials 
(the Product) and is the Licence referred to on the packaging of the Product. HOWEVER, if the Licence Agreement 
contains anything of which you were not aware prior to purchasing the Product or do not agree to be bound by, DO NOT 
INSTALL THE SOFTWARE but return the Product to the reseller in its entirety and a full refund of the purchase price will be 
made. For the purpose of this agreement the Product shall include any modified versions and upgrades subsequently 
licensed to you. By installing and retaining the Product you are confirming that you have purchased the Product subject 
to this Licence and are bound by its provisions.

1 Scope of Licence
MYOB Technology Pty Ltd ('MYOB') through its local publishers, and distribution agents, hereby grants to you, the 
original purchaser, a paid-up, personal, non-exclusive and non-transferable Licence to use the Product subject to the 
terms and conditions of this Agreement.

a Single Computer Network You may use the Product on only one computer network that you own or operate at 
a single physical location and only then in respect of data files created by you or by another licensed user. You may 
transfer the Product from one computer to another that you own or operate on this network provided that you 
do not use or permit the usage of the Product on more than the licensed number of computers or computer ter-
minals at a time, nor permit the usage of the Product on more than one network at any one time, nor permit the 
Product to be used in respect of data files not created by you or by another licensed user. In the event of an 
upgrade or product exchange the Licence hereby granted is automatically transferred to the new version or prod-
uct. All rights in respect of the original product shall lapse and no further use of same shall be permitted.

b Copies You may not copy or duplicate the Product, except as necessary solely for archival purposes, Product 
error verification, or to replace 
defective storage media, provided you keep the original and the copies. You may not alter, decompile or 
disassemble the Product. You may not make copies of the related explanatory materials.

c Transfers You may not sub-license, lease, rent or lend the Product or otherwise transfer any of your rights under 
this Agreement. Subject to the prior written consent of MYOB and the agreement of the transferee to be bound 
by the terms of this Agreement, you may permanently transfer the Product (together with any backup copies you 
have made). However, you may not retain any copies of the Product.

d Term The Licence granted in this Agreement is effective until terminated. You may terminate it at any time by 
destroying the Product, together with all copies, or by returning them to MYOB. If you fail to comply with any 
term or condition of this Agreement, this Licence will terminate and, upon any such termination, you agree to 
destroy the Product, together with all copies, or to return them to MYOB. Termination of this Licence shall be in 
addition to and not in lieu of any other remedies available to MYOB. Where you have entered into a Subscription 
Agreement with MYOB in respect of your use of the Product, the Licence granted in this Agreement will terminate 
if the Subscription Agreement terminates.

e Protection and Security You agree to use your best endeavours and to take all reasonable steps to safeguard the 
Product to ensure that no unauthorised person has access to the Product and that there is no unauthorised 
copying or distribution of the Product.

f Subscription Sale If purchased under a subscription sale the right to use the software relies on you continuing to 
pay the monthly subscription fee.

2 Product Support
Where purchased under a Subscription Sale in respect of your use of the Product, your payment of the monthly 
subscription fee entitles you to ongoing support for the current version of the Product.

The initial purchase price may include a period of support notified to you by MYOB. On the expiration of this period, 
further support can be obtained at your expense.

3 Limited Warranty and Disclaimer
MYOB warrant that the media on which the Product is provided are free from defects in materials and workmanship 
under normal use for a period of 90 days from the date of your original purchase. Except for the limited warranty 
described above, the Product is sold 'as is', and you are assuming the entire risk as to its quality and performance. It 
is your responsibility to verify the results obtained from the use of the Product.

If during the 90-day limited warranty period, you discover physical defects in the media on which the Product is 
supplied, MYOB will replace it at no charge to you, provided you return the item to be replaced with proof of 
purchase to MYOB. THIS IS YOUR SOLE REMEDY. IN NO EVENT WILL MYOB BE LIABLE TO ANY PERSON FOR ANY 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, EVEN IF MYOB HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Some jurisdictions do not allow the exclusion or limitation of implied warranties or of liability for incidental or 
consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific 
legal rights and you may also have other rights that vary from state to state. In the event that any of the above 
limitations or exclusions are held to be unenforceable, MYOB's total liability shall not exceed the amount of the 
Licence fee you paid.

4 Entire Agreement
This Licence (and Subscription Agreement if applicable) constitutes the entire agreement between MYOB and you 
and any prior representations, statement or undertaking howsoever made are expressly cancelled. No amendment 
or modification to this Licence shall be valid unless it shall be in writing and signed by an authorised representative 
of MYOB.
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1  Getting Started
MYOB RetailEnterprise streamlines management across multiple retail stores by giving you a 
global view of your retail operations.

RetailEnterprise consists of two components: 

the Central module, through which head office communicates with each store

the Shop module, through which each store communicates with head office. (The Shop 
module is described in the MYOB RetailEnterprise Shop User Guide.)

About this manual

This user guide provides detailed information about the features and benefits of 
RetailEnterprise Central in your central office. It is designed to be used as a reference for 
everyday tasks as well as tasks that you may only perform periodically, such as importing and 
archiving data and collecting information from each retail outlet.

Chapter 1 (this chapter) explains how to install and register RetailEnterprise Central and 
how to apply for extra licences if you need them.

Chapter 2, Setting Up, on page 23 describes how to set up the RetailEnterprise Central 
database for your shops, suppliers and products. It also contains important information on 
setting up your computer to enable key functions of RetailEnterprise Central to occur.

Chapter 3, Using RetailEnterprise Central, on page 53 details how to set up and maintain 
information about products, shops and suppliers. It also explains how to collect summary 
information and generate reports on the daily point-of-sale processing in RetailManager on 
your shop terminals.

Chapter 4, Administration, on page 85 explains how to manage your database and archive 
your data.

Appendix A:, ‘Troubleshooting’, on page 97 describes common problems with 
RetailEnterprise Central and how to deal with them.

Appendix B:, ‘MYOB technical support’, on page 99 details your MYOB technical support 
options.

NOTE : MYOB RetailEnterprise or MYOB RetailManager Enterprise? MYOB RetailManager 
Enterprise is now referred to as MYOB RetailEnterprise.
7
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Overview of MYOB RetailEnterprise

The main feature of MYOB RetailEnterprise is the capacity to establish electronic 
communication between your central office and each of your shops. This enables you to send 
information such as product and pricing updates to shops, and also collect a daily summary of 
sales and stock levels from RetailManager in the shops.

The major benefit to your central office is that RetailEnterprise Central enables you to:

manage and share a central inventory database between your shops and central office

distribute centralised product updates if you have a central pricing policy

distribute information about stock holdings in other shops to each shop in your network

choose which shops to collect a daily summary from, and whether the summary should 
include daily sales, stock figures or both

produce sales reports such as What’s Selling in the shops, and product reports such as 
What’s in Stock in the shops.

The major benefit to your shops is that MYOB RetailEnterprise interfaces with RetailManager. 
This is because RetailEnterprise works behind the scenes and involves minimal extra effort in 
the shops. For example, the collection of sales and stock figures can be scheduled to occur at 
the quiet times for your shops, typically at night.

Typical RetailEnterprise Central model
The illustration below shows a typical model of how RetailEnterprise Central works in a retail 
business like yours. 

Daily sales and stock figures

Centralised product updates

Messages

Central office computer

Shop A

Shop B

Shop C
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As the illustration shows, RetailEnterprise Central enables your central office to send and 
receive information from the shops. 

MYOB RetailEnterprise modules
This section outlines how MYOB RetailEnterprise works for your organisation generally, and 
specifically in your central office. 

The MYOB RetailEnterprise software is made up of two distinct modules:

the Central module for your central office—for example, the head office.

the Shop module for each shop—for example, a retail outlet or branch office.

Each module is designed to perform the different activities that are specific to the two types of 
locations. For example, the Central module enables you to make the product updates at your 
central office, while the Shop module enables shops to receive centralised product updates.

The illustration below shows the functions of each of these modules within MYOB 
RetailEnterprise:

Daily sales and stock figures

Centralised product updates

Messages

Central office computer

Shop A

Shop B

Shop C

Central office module
Collecting summary information from shops
Maintaining shop details
Maintaining product details
Dispatching messages and product updates to shops
Producing reports

Shop module
Receiving messages from central office
Receiving centralised product updates
Creating summary information for collection
O V E R V I E W  O F  M Y O B  R E T A I L E N T E R P R I S E   9
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Central module

This module of MYOB RetailEnterprise enables your central office staff to:

monitor the collection process that collects daily sales and stock data from shop

maintain details of every shop

maintain details of products

broadcast messages to shops 

create and broadcast product updates

broadcast stock holding information to shops

generate reports based on the sales and stock data collected from shops.

Shop module 

This module of MYOB RetailEnterprise runs on a computer terminal in the shops. Occasionally, 
shops may need to respond to events or messages initiated by staff in your central office. This 
module enables the shop to:

receive product updates from your central office

receive information about stock holdings at other shops in your network

create summary information for the collection process that is launched in your central 
office.

Checklist for implementation 

This section contains a checklist for implementing RetailEnterprise Central in your business. 
The checklist is included especially for first-time users of RetailEnterprise Central. We 
recommend that you follow the sequence of steps in the checklist to implement 
RetailEnterprise Central. 
C H A P T E R  1 G E T T I N G  S T A R T E D



Implementation checklist—Central

Step Action By who

1 Ensure you have the appropriate hardware and software to establish 
communications between your central office and shops. 
• For a direct dial-up connection—a data/fax modem, cables and a 

dedicated phone line
• For a LAN/WAN connection—LAN connection cabling and software
• For email communication—a POP or IMAP email account and an 

Internet connection.

Hardware supplier, 
Telecomms 
provider

2 Coordinate and manage the rollout of RetailEnterprise to each shop. Central office staff

3 Arrange for each shop to:
• set up MYOB RetailEnterprise Shop using the Shop implementation 

checklist (see the MYOB RetailEnterprise Shop User Guide)
• forward connection details to your central office when finished.

Shop manager

4 Install RetailEnterprise Central in your central office.
See ‘Installing MYOB RetailEnterprise Central’ on page 13.

Central office staff 

5 Register RetailEnterprise Central.
See ‘Registering MYOB RetailEnterprise Central’ on page 16.

Central office staff

6 Determine if you need additional shop licences.
See ‘Do you need additional shop licences?’ on page 21.

Central office staff

7 Understand your technical support options.
See ‘MYOB technical support’ on page 99.

Central office staff

8 Set up communications between central and shop, depending on your 
chosen communications method.
See ‘Setting up dial-up networking between central office and shops’ on 
page 45, ‘Setting up email communication between central office and 
shops’ on page 49, and the separate Communications Setup Guide which 
you can access from the Help menu.

Central office staff 
or RetailManager 
Professional

9 Set up your computer’s regional settings, and general settings for 
RetailEnterprise Central.
See ‘Specifying regional settings’ on page 27 and ‘Specifying 
RetailEnterprise Central settings’ on page 30.

Central office staff

10 Identify the geographic regions of your business (for shops) for 
RetailEnterprise Central. This is necessary to set up your regions in the 
next step.

Central office staff

11 Set up your central database of regions and shops, suppliers and products 
in RetailEnterprise Central. You will need the connection details unique to 
each of your shops. See ‘Setting up your Central database’ on page 32.

Central office staff

12 Test the connection to each shop. Central office staff

13 Carry out a pilot collection of Summary Information from your shops. Central office staff
C H E C K L I S T  F O R  I M P L E M E N T A T I O N   1 1
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Additional notes on the checklist
This section contains additional notes about some checklist steps.

Purchase and install modem, phone connections If your business needs advice on how 
to go about this, contact an MYOB RetailManager Professional. For more information, see 
‘MYOB RetailManager Professionals’ on page 106.

Coordinate rollout of MYOB RetailEnterprise to shops This is a critical phase of the whole 
implementation. You need to pay particular attention to ensuring the shops successfully install 
and set up the hardware and software needed to fully implement MYOB RetailEnterprise. 
Depending on the size of your business, it may be worth preparing a plan for the rollout by 
shop or by region. The MYOB RetailEnterprise Shop installation disk supplied is to be used for 
each additional shop.

Shop-by-shop rollout In the shops, the relevant person must implement MYOB 
RetailEnterprise using the checklist provided in the separate MYOB RetailEnterprise Shop User 
Guide. Ensure that the shops record and send you their unique connection details—such as the 
dedicated phone number for their modem.

Identify the geographic regions for your shops In RetailEnterprise Central, you need to 
identify regions for grouping your shops geographically. For example, by State for national 
organisations, or suburb for metropolitan organisations. You will need to enter the regions 
when you set up your central database in the step below.

Set up your RetailEnterprise Central database See ‘Setting up your Central database’ on 
page 32. This includes setting up:

regions—as identified in the previous step

shops—including the connection details unique to each shop

suppliers

products. 

TIP : To use an existing RetailManager database If you have an existing RetailManager 
database in your shops, you can import your existing supplier and stock details into 
RetailEnterprise Central. For more information, contact one of our MYOB RetailManager 
Professionals. See ‘MYOB RetailManager Professionals’ on page 106 for more information about 
MYOB RetailManager Professionals.

Test shop connections Having set up your shop details in MYOB RetailEnterprise, you 
should now test the connection to each shop. See ‘Maintaining shop details’ on page 57. If 
you have problems with this step, you may need to contact technical support. For more 
information see ‘MYOB technical support’ on page 99.

Trigger a pilot collection Again, having successfully tested all your shop connections, you 
should now manually trigger a pilot collection of summary information from a small group of 
shops. See ‘Collecting summary information from shops’ on page 67. If you have problems 
with this step, you may need to contact technical support. For more information see ‘MYOB 
technical support’ on page 99.
C H A P T E R  1 G E T T I N G  S T A R T E D



Installing MYOB RetailEnterprise Central 

System requirements
Check that your computer meets the following requirements. We strongly advise that you use 
computers that meet the recommended requirements.

Before you install RetailEnterprise Central 
Do you need additional shop licences? When you purchase MYOB RetailEnterprise you 
are licensed for up to five shops. You can purchase additional shop licences when you 
register RetailEnterprise. See ‘Do you need additional shop licences?’ on page 21.

Check that you have at least one printer installed. RetailEnterprise Central will need a 
printer installed and set as the default printer so you can view and print reports.

Disable your anti-virus program. If you use an anti-virus program, disable it before you 
install this version.

Operating system Recommended: Windows® Vista Ultimate (Service Pack 1), Windows Vista 
Business (Service Pack 1), Windows XP Professional (Service Pack 3)
Minimum: Windows XP Professional (Service Pack 1) or Windows 2000 (Service 
Pack 4)

Processor Recommended: Pentium® 4 processor (or equivalent) at 1.5GHz or faster
Minimum: Pentium III processor (or equivalent) at 500MHz

Memory Recommended: 512MB RAM or more
Minimum: 256MB RAM

Hard disk Recommended: 10GB or more of free disk space
Minimum: 1GB of free disk space

Display Recommended: 1024x768 dpi resolution
Minimum: 640x480 dpi resolution

Communications Appropriate hardware and software to set up communications between your 
central office and shops. 
• For a dial-up connection between your central office and shops—a data/fax 

modem, cables and a dedicated phone line
• For a LAN/WAN connection—LAN connection cabling and software
• For email communication—a POP or IMAP email account and an Internet 

connection.

Printer A local or network printer to print reports.

Mouse and keyboard Windows-compatible mouse and keyboard

Backup solution We strongly recommend a backup solution such as a CD/DVD writer or a USB 
storage device.
I N S T A L L I N G  M Y O B  R E T A I L E N T E R P R I S E  C E N T R A L   1 3
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To install RetailEnterprise Central

1 Before you start, close all open applications. This is very important for correct installation. 
You will need to restart your computer when the installation is complete.

2 Log in as an Administrator (for Windows Vista users), or as an Administrator or Power User 
(for Windows XP or 2000 users whose computers only allow people with administrator 
privileges to install programs).

NOTE : Logging into Windows Vista as a Standard user If you have the Administrator 
password, you may be able to log into Windows Vista as a Standard user. You can then install 
RetailEnterprise Central.

3 Insert the MYOB RetailEnterprise Central CD and wait a few moments. A welcome window 
appears.

If a welcome window does not appear automatically:

The welcome window appears. If the welcome window still does not appear, double-click 
the autorun.exe file.

4 Select the installer:
[Australia and New Zealand] Click Install RetailEnterprise Central. 
[Hong Kong, Malaysia and Singapore] Click Select RetailEnterprise Central installer, 
and then select the installer for your country.

The Welcome to MYOB RetailEnterprise Central v4 Setup window appears. 

5 Follow the onscreen instructions.

NOTE : Warnings If any warnings appear during installation, see ‘Troubleshooting your 
installation’ on page 15. 

6 When the Installation Complete window appears, click Finish.

Your computer will restart automatically. If your computer does not restart automatically, 
you should restart it manually.

Your desktop will now have a shortcut to MYOB RetailEnterprise Central.

NOTE : Install Adobe Reader to view PDF versions of the user guides You will need to install 
Adobe Reader to view the PDF versions of the user guides provided with your software.
To install Adobe Reader, click Resources in the welcome window of the MYOB RetailEnterprise 
Central v4 CD.

If you are using... do this...

Windows Vista 1 Go to the Start menu and click Computer.

2 Click your CD or DVD drive icon (usually labelled D:\ 
or E:\) in the right pane of the Computer window.

Windows XP or 2000 1 Go to the Desktop and double-click My Computer.

2 Double-click your CD or DVD drive icon (usually labelled D:\ 
or E:\) in the right pane of the Computer window.
C H A P T E R  1 G E T T I N G  S T A R T E D



Troubleshooting your installation
During the installation of RetailEnterprise Central, it is possible that you may get the following 
warnings or error messages. 

For help with resolving other installation issues, contact technical support. For more 
information see ‘MYOB technical support’ on page 99.

Starting MYOB RetailEnterprise Central 

NOTE : Evaluation copy limitations You can access MYOB RetailEnterprise Central 25 times or for 
30 days after which you will need to register the software to continue using it.

To start using RetailEnterprise Central

1 Double-click the MYOB RetailEnterprise Central v4 icon on your desktop. The following 
window appears.

2 If you want:
to register MYOB RetailEnterprise now, click Yes. See ‘Registering MYOB RetailEnterprise 
Central’ on page 16. 

If the following warning 
message appears...

do this...

Read Only File Detected Select the Don’t display this message again option and click Yes. The 
application will continue to install.

Locked File Detected Select the Don’t display this message again option and click Reboot. 
The application will continue to install.

Files Failing to Self-Register Click OK. This warning does not affect the installation of the software.
S T A R T I N G  M Y O B  R E T A I L E N T E R P R I S E  C E N T R A L   1 5
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to register MYOB RetailEnterprise later, click No. Go to step 3. The following information 
window appears.

This window tells you how many times you can use MYOB RetailEnterprise until you 
exceed your evaluation limit of 25 uses or 30 days. 

3 Click OK.

4 If the About MYOB RetailEnterprise window appears, click OK.

You are now ready to start using RetailEnterprise Central in evaluation mode.

Registering MYOB RetailEnterprise Central 

You need to register in order to:

continue using MYOB RetailEnterprise. RetailEnterprise allows you to open your shopfront 
25 times or for 30 days, before you must register it. If you still haven’t registered, you will 
not be able to start the program until you enter your registration unlock code. 

purchase additional shop licences for RetailEnterprise. See ‘Do you need additional shop 
licences?’ on page 21 for more information.

receive information about RetailEnterprise upgrades, new products, special offers and 
other services.

upgrade RetailEnterprise.

be eligible for support.

How to register
You should have received a registration form with your software. The registration form 
contains complete instructions on how to register. 

Locate the serial number printed on the CD sleeve or on the registration form. You will need 
this number when you register. The registration process comprises three steps.

Step Task See

1 Enter your registration details in RetailEnterprise Central page 17

2 Contact MYOB to receive your unlock code page 18

3 Enter the unlock code in RetailEnterprise Central page 20
C H A P T E R  1 G E T T I N G  S T A R T E D



Step 1: Enter your registration details in RetailEnterprise 
Central
1 Start MYOB RetailEnterprise Central v4. The following message appears. 

2 Click Yes. An MYOB RetailEnterprise registration form similar to the one shown below 
appears.

NOTE : Telephone number The telephone number displayed above is only an example.

3 Complete the fields in this form.

[Australia only] It’s important for you to enter your email address so you can receive 
product updates and our regular e-newsletter.

CAUTION : Ensure that your registration details are accurate The trading name, street 
address and telephone number you enter in the registration form are printed on all your sales 
dockets. Therefore, you should ensure that these details are accurate. If you need to change any 
details at a later stage, you will need to reregister through MYOB.

If you decide not to register now, you can run RetailEnterprise Central in evaluation mode. 
To do this, click Run Evaluation. Note that any details you enter will be saved. When you 
are ready to register later, simply repeat this procedure starting from step 1 above.
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4 In the Serial Number field, enter the serial number printed on your RetailEnterprise 
Central v4 CD sleeve or registration form.

5 Click Generate Registration Key. A message appears.

6 Click Yes to continue. The registration key appears below the Generate Registration Key 
button.

7 [Australia, New Zealand, Malaysia and Singapore] Click Print Registration to print the 
registration details. 

[Hong Kong] Write the registration key on the printed registration form supplied in the 
product box. Complete the remaining fields in the printed registration form.

8 Go to ‘Step 2: Contact MYOB to receive your unlock code’ below.

Step 2: Contact MYOB to receive your unlock code

Now that you have entered your registration details into RetailEnterprise Central, and have 
generated the registration key, you need to register these details with MYOB to receive an 
unlock code.

Australia

To receive the unlock code by fax Fax the registration form that you printed using 
RetailEnterprise Central to 03 9222 9898.

We will fax you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ on page 20.

If you’re in... See...

Australia below

New Zealand page 19

Hong Kong page 19

Malaysia page 20

Singapore page 20
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To receive the unlock code by mail Mail the registration form that you printed using 
RetailEnterprise Central to:

MYOB Australia Pty Ltd
Reply Paid 371
Blackburn VIC 3130

We will mail you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ on page 20.

To receive the unlock code online Visit my.myob.com, click Register your MYOB 
software and enter your registration information.

We will email you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ on page 20.

To receive the unlock code by telephone Call 1300 555 115 between these times: 
9.00am to 7.00pm EST Monday to Wednesday
9.00am to 9.00pm EST Thursday to Friday
9.00am to 5.00pm EST Saturday to Sunday

You will need to quote the registration details that you entered in RetailEnterprise Central. We 
will read out your unlock code, which you will need to enter in RetailEnterprise Central. See 
‘Step 3: Enter the unlock code in RetailEnterprise Central’ on page 20.

New Zealand

To receive the unlock code by fax Fax the registration form that you printed using 
RetailEnterprise Central to 03 983 2610.

We will fax you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ on page 20.

To receive the unlock code by mail Mail the registration form that you printed using 
RetailEnterprise Central to:

MYOB New Zealand Pty Ltd
PO Box 2864
Christchurch

We will mail you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ on page 20. 

Hong Kong

To receive the unlock code by fax You must complete the printed registration form 
supplied in the RetailEnterprise Central box or download a registration form from 
myob.com.hk. Fax the completed registration form to (852) 3402 9848.

We will fax you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ on page 20.
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Malaysia

To receive the unlock code by fax Fax the registration form that you printed using 
RetailEnterprise Central to (603) 8991 0177.

We will fax you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ below.

Singapore

To receive the unlock code by fax Fax the registration form that you printed using 
RetailEnterprise Central to (65) 6505 6577.

We will fax you confirmation of your registration, including your unlock code. When you 
receive your unlock code, enter it in RetailEnterprise Central. See ‘Step 3: Enter the unlock 
code in RetailEnterprise Central’ below.

Step 3: Enter the unlock code in RetailEnterprise Central
When you have received your unique unlock code from MYOB, you need to enter it in 
RetailEnterprise Central. The RetailEnterprise Central registration reminder appears every time 
you open RetailEnterprise Central while unregistered. 

1 Start MYOB RetailEnterprise Central and choose to register. The registration form appears. 

2 Enter your unlock code in the Unlock Code field. 

3 Click Register Unlock Code. The following window appears.

4 Click OK. You have now registered your copy of MYOB RetailEnterprise Central.
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Do you need additional shop licences?

When your business first installs and registers MYOB RetailEnterprise Central, you are supplied 
with five shop licences. If your business needs to bring more shops online after you have 
registered RetailEnterprise Central, you must purchase and register additional shop licences.

NOTE : Additional licences are only available for current versions of RetailEnterprise

How do I purchase additional shop licences?
You can purchase additional shop licences when you register RetailEnterprise Central for the 
first time, or at a later stage. 

You can purchase additional shop licences by calling MYOB.

After MYOB processes your request, you will receive confirmation that you have purchased 
additional shop licences. At the same time you will be given an unlock code that entitles you 
to start using the additional shop connections. You must use this unlock code in the procedure 
below to register an additional shop licence.

NOTE : You must register RetailEnterprise Central You must have registered RetailEnterprise 
Central before you can purchase an additional shop licence. You can purchase additional shop 
licences at the same time as you register MYOB RetailEnterprise Central v4. 

If you are in... call...

Australia 1300 555 115

New Zealand 0508 123 123

Malaysia 1300 88 0883 or (603) 8991 0166

Singapore (65) 6505 6582

Hong Kong (852) 3402 9882
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How do I register an additional shop licence?
You need to register your additional shop licences before you can bring the shops online and 
start sending or collecting information from them.

TIP : Still using an evaluation copy of RetailEnterprise Central? If you have not yet registered 
your copy of MYOB RetailEnterprise Central v4, do so now as described in ‘Registering MYOB 
RetailEnterprise Central’ on page 16.

1 Do you have the unlock code supplied by MYOB for your additional shop licences?
If yes, go to step 2 below.
If no, see ‘How do I purchase additional shop licences?’ on page 21.

2 Double-click the MYOB RetailEnterprise Central v4 icon on your desktop. The MYOB 
RetailEnterprise - Central window appears.

3 Go to the Help menu and choose Company Details. The Company Details window 
appears.

4 Enter the unlock code supplied by MYOB in the New Unlock Code field.

5 Click Register Unlock Code. 

You can now try out your additional shop licences by sending or receiving information from 
the shops. For more information about this, see ‘Sending messages to shops’ on page 61 and 
‘Collecting summary information from shops’ on page 67.
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This chapter describes how to set up MYOB RetailEnterprise Central for your business. It 
explains how to:

set regional options for your computer

set RetailEnterprise Central options

set up dial-up networking and email communication between your central office and 
shops for Windows Vista Ultimate, Windows XP Professional and Windows 2000.

The first part of the chapter describes some basic navigation techniques you’ll need for using 
RetailEnterprise Central.

Use this information after you have installed and registered the software as described in the 
Getting Started chapter.

Starting MYOB RetailEnterprise Central

To start RetailEnterprise Central

Do one of the following:

Double-click the MYOB RetailEnterprise Central v4 icon on your desktop.

Go to Start, choose Programs, MYOB RetailEnterprise - Central v4, and then MYOB 
RetailEnterprise - Central v4.

You are now ready to start using RetailEnterprise Central.

Navigating 

This section describes the basics of navigating your way around MYOB RetailEnterprise Central 
in your central office. The basics of navigation include the use of:

common Windows® features such as grids, buttons, and checkboxes – that mainly involve 
using the mouse

fields for data entry and display

keyboard features such as shortcut keys.

If you’ve used Windows before, you will already be familiar with most of the techniques you 
need to get around in RetailEnterprise Central.
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Common Windows features

RetailEnterprise Central window example

The illustration below shows the title bar, a grid, button and the message bar:

NOTE : To display the example window (Products window) To display the example window 
above, go to the Information menu and choose Products.

Title bar

The title bar identifies the product and function of the current window.

Grids 

A grid is an arrangement of data with two or more columns in which the information in the 
first column relates specifically to the information in the other column or columns. 

Buttons

Buttons are provided for different functions. For example, clicking the Commit button (shown 
below) saves data to the database. 

Message bar Button

Grid

Title bar
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Message bar

The message bar displays information relevant to the current field. In RetailEnterprise Central, 
most windows have a message bar at the bottom of the window as shown below. 

The field information in the message bar changes as you move from field to field.

Checkboxes

Checkboxes let you select or deselect options. You can either:

select to turn on an option or 

deselect to turn off an option. 

You can select more than one checkbox when there are multiple checkboxes, if applicable. 

Tabs 

Tabs enable you to access many different options or functions from the same window. 

Types of fields
There are various types of fields in RetailEnterprise Central which are used for either entering 
data or displaying information. Fields that are used to enter data are usually referred to as input 
fields, while fields that are filled by the system are referred to as display fields.

Text fields A text field enables you to enter a combination of letters, numbers or special 
characters. If the field already contains text, you can delete the text, change it or overwrite it 
completely. 

List fields A list field enables you to select a valid entry from a list of available options or 
entries. The list is displayed in either a small, fixed window that you can scroll to select the 
option you need, or from a drop-down list you have to activate. 

Drop-down lists show a list of available options for a field. To display a drop-down list, click the 
arrow to the right of the field as shown below:

While in some list fields you can only select from the list of available options, in other fields you 
can either select from the list or type a new entry that is not in the list.
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Keyboard shortcuts
Some RetailEnterprise Central functions can be performed using standard keyboard shortcuts; 
others are specific to RetailEnterprise Central.

STANDARD NAVIGATION KEYS

FUNCTION KEYS

FILE MENU COMMANDS

INFORMATION MENU COMMANDS

Press … To …

TAB Move to the next step

ENTER Move to the next step

SHIFT+TAB Move back one step

ESC Close the current window

SPACEBAR Select an option in a window

¦ (Up arrow) Move up in a list or grid

Ø (Down arrow) Move down in a list or grid

Press … To …

F1 Open the Help (from any window)

F2 Open the Search for Shops window (from Transfer Audit 
window and Connection Event Logs window)

F5 Create a new item (for Products, Shops, Suppliers, Regions)

Press … To …

CTRL+N Create a new item (for Products, Shops, Suppliers, Regions, 
Tax Codes, Messages)

CTRL+O Open the item you have selected (for Products, Shops, 
Suppliers, Regions, Tax Codes, Messages) 

Press … To …

CTRL+R Open the Products window

CTRL+S Open the Shops window

CTRL+U Open the Suppliers window

CTRL+G Open the Regions window

CTRL+X Open the Tax Codes window
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CREATE MENU COMMANDS

TRANSFERS MENU COMMANDS

Closing a window
In RetailEnterprise Central there are three ways to close a window:

Click Close

Press ESC

Click the close icon ( ) in the top right corner of the window.

Specifying regional settings

To get the best results from RetailEnterprise Central, you need to specify the correct regional 
settings on your computer.

In Windows, make sure your system settings reflect the following:

Press … To …

CTRL+M Open the Messages window

CTRL+D Open the Product Update Transfers window

Press … To …

CTRL+T Open the Manual Transfer window

Numbers tab • Decimal symbol is set to a decimal point
• No. of digits after decimal is set to 2
• Digit grouping symbol is set to a comma
• Negative number format is set to -1.1
• Measurement system is set to Metric

Currency tab • [Australia, New Zealand, Hong Kong and Singapore] Currency symbol is set to $
[Malaysia] Currency symbol is set to RM

• Decimal symbol is set to a decimal point
• No. of digits after decimal is set to 2
• Digit grouping symbol is set to a comma

Date tab • [Australia, New Zealand, Malaysia and Singapore] Short date style is set 
to dd/MM/yyyy
[Hong Kong] Short date style is set to yyyy/MM/dd
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To set your regional settings 

1 Open your regional settings window: 

2 Click the Numbers tab and set the following:
Decimal symbol to a decimal point
No. of digits after decimal to 2
Digit grouping symbol to a comma
Negative number format to -1.1
Measurement system to Metric.

If you are using... do this...

Windows Vista 1 Go to the Start menu and choose Control Panel.

2 Click Clock, Language, and Region and then click Change the date, 
time, or number format. 

3 In the Formats tab, select your language and region from the Current 
format drop-down list (for example English (Australia)).

4 click Customize this format.

Windows XP 1 Go to the Start menu and choose Control Panel. 

2 Click Regional and Language Options. 

3 In the Regional Options tab, select your language and region from the 
Standards and formats drop-down list (for example 
English (Australia)).

4 Click Customize.

Windows 2000 1 Go to the Start menu, choose Settings and then choose Control Panel.

2 Double-click Regional Options.

3 In the General tab, select your language and region from the Your locale 
(location) drop-down list (for example English (Australia)).
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3 Click the Currency tab and set the following:
[Australia, New Zealand, Hong Kong and Singapore] Currency symbol to $
[Malaysia] Currency symbol to RM (you will have to enter this manually)
Decimal symbol to a decimal point
No. of digits after decimal to 2
Digit grouping symbol to a comma

4 Click the Date tab and set the short date format to:
[Australia, New Zealand, Malaysia and Singapore] dd/MM/yyyy 
[Hong Kong] yyyy/MM/dd 

5 Click Apply and then click OK.
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Specifying RetailEnterprise Central settings

These settings are fundamental to the correct operation of MYOB RetailEnterprise Central in 
your central office. 

The settings include:

schedule time for the collection process 

archive options

backup options.

Although you need to set up these options when you first start using RetailEnterprise Central, 
you can change these settings at a later stage if required. For example, if you initially set up a 
start time for the collection process that is too early for some shops, you can change the start 
time later. 

For more information on the collection process, see ‘Collecting summary information from 
shops’ on page 67.

To specify your RetailEnterprise Central settings

1 Go to the File menu and choose Settings. The Settings window appears.

2 If you want to automate the collection process, select the Activate Schedule option.

3 In the Collection Interval field, specify how often you want to collect summary 
information from your shops. 

If you select the Daily every 24 hours option, enter the time you want RetailEnterprise 
Central to start collecting information in the Collection Time field. For example, if you 
want RetailEnterprise Central to collect information every day at 6.00pm, enter that time 
in the Collection Time field.
If you select one of the other available options, such as Every hour, RetailEnterprise 
Central will automatically collect information at the next interval, on the hour. For 
example, if the time is currently 10.48am, and you select the Every hour option, 
RetailEnterprise Central will start collecting information at 11.00am, and every hour after 
that.
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4 In the No. of Retries field, type the number of retries the collection process should attempt 
when dialling up a shop or contacting a shop on a LAN/WAN. 

For example, if this field is set to ‘3’ and the first dial-up attempt fails, the collection process 
will make three more attempts to dial up a shop.

NOTE : Unsuccessful collection If the connection attempt is unsuccessful, the summary 
information for that shop cannot be collected. This failure is recorded in the Event Log for you to 
review and resolve the problem. See ‘To view the connection event log’ on page 82.

5 In the Archive data more than x days old field, enter the maximum number of days you 
want to keep current data for. 

NOTE : Archiving non-current data Non-current data is retained in a separate archive 
database. Non-current data is any shop or event log data older than the number of days entered 
in the Archive data more than x days old field. This means that your reports will not include 
non-current data that has been archived.

6 To compact the database, click Compact. Click Yes to close any open RetailEnterprise 
Central windows and begin database maintenance. This is a useful procedure if your 
database is large as it can improve the speed of data retrieval.

7 If you want to see a connection progress window when you connect through a dial-up 
connection, select the Display progress while connecting option. 

If you do not select this option, RetailEnterprise Central will connect in the background and 
only display the result of the connection attempt.

8 To change the path of the backup file to be created:
a Click Browse to display the Open window.
b Browse for the required location and then click Open.

9 Click Save to save your changes to the settings options.

For more information about archiving, see ‘To archive non-current data’ on page 86.

For more information about backing up, see ‘To back up your Central database’ on 
page 85.

10 Click Close to close the Settings window.

To change your settings

Changes to the Schedule settings in the Settings window will only take effect at the time you 
enter as the start time (if you chose the Daily every 24 hours option), or at the next interval (if 
you chose one of the other collection interval options). 

Changes to the Maintenance settings normally take effect when the automatic archive 
process happens, unless you click Archive Now to archive immediately. 

Changes to the Backup Database settings only take effect when you click Backup to back up 
immediately. 

To make changes to your RetailEnterprise Central settings, see ‘To specify your RetailEnterprise 
Central settings’ on page 30.
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Setting up your Central database

When you first install MYOB RetailEnterprise at your central office, you will need to set up your 
Central database of:

suppliers and products

regions and shops.

You have to set up the suppliers before setting up products because each product must be 
assigned to a supplier. Similarly, you have to set up your regions before setting up shops so 
each shop can be assigned to a region. 

Setting up tax codes
When you create a stock item, you need to assign a tax code. 

Basic tax codes have been set up in RetailEnterprise Central, and are described in the following 
table. In addition to the tax codes listed, you have the option to add new tax codes depending 
on the needs of your business. See ‘To create a new tax code’ on page 33 for more 
information. 

Region Tax Code Description

Australia FRE 

(GST-Free)

This tax code is used if you are operating under the GST 
system, for items that are GST-free such as some types of 
food, medical supplies, educational material, etc.

GNR 

(GST Non-Registered)

This tax code is used if you are not registered for GST (i.e. 
if your annual turnover is less than $50,000 or if you are a 
non-profit organisation).

GST

(Goods & Services Tax)

This tax code is used if you are operating under the GST 
system, for items that attract GST.

INP

(Input Taxed)

This tax code is used if you are operating under the GST 
system, for input taxed supplies such as finance charges 
and residential rents. 

New 
Zealand

E

(Exempt)

This tax code is used for items that are exempt from or not 
subject to GST such as financial services, and donated 
goods and services that are sold by non-profit bodies.

S

(Standard 12.5% GST)

This tax code is used if you are operating under the GST 
system, for items that attract GST. This tax code is set up 
for a rate of 12.5%.

Z

(Zero Rated)

This tax code is used for zero-rated supplies. Zero-rated 
supplies are covered by GST laws, but GST is charged at a 
rate of 0%.

Malaysia GVT (Government Tax) Use this code for stock items that attract Government Tax.
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NOTE : Using tax codes If you are unsure about the tax applicable for an item, check with your tax 
consultant or your local taxation office. You can change the default tax code for sales and purchases.

Setting up default tax codes Default tax codes can be set for sales and purchases. 

When you set up default sale and purchase tax codes, any new stock item you create in 
RetailEnterprise Central will be assigned these default tax codes. 

Make sure the default tax codes you enter reflect the tax code of the majority of your stock 
items.

[Australia] For example, the majority of items that a gift shop purchases and sells will attract 
GST, therefore, the default purchase and sale tax codes should be set to GST. On the other 
hand, a fruit shop should probably set the purchase tax code to FRE (as fruit is GST-free), and 
default sale tax code to FRE, as fresh food does not attract GST. 

You can change an item’s default tax codes in the Product Information window (see ‘To set 
up a product’ on page 35). 

To create a new tax code

1 Go to the Information menu and choose Tax Codes. The Tax Codes window appears.

Singapore GST (Goods & Services 
Tax)

Use this code for stock items that attract GST.

All regions N-T (No tax) [Australia and New Zealand] This tax code is used for 
items that are out of scope of GST (for example, in 
Australia, salaries and wages and security deposits).
[Hong Kong, Malaysia and Singapore] Use this code for 
stock items that do not attract tax.

Region Tax Code Description
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2 Go to the File menu and choose New (or press CTRL+N). The Tax Code Information 
window appears. 

3 Enter the tax code you want to create in the Tax Code field. This code can be up to three 
alphanumeric characters. 

4 Enter a description for the tax code in the Description field. 

5 Select the tax type by clicking in the Tax Type field and choosing from Goods and 
Services Tax, Input Taxed, and Sales Tax.

6 Enter the tax rate in the Rate field.

7 Click Commit to commit the information.

8 Click Close to close the Tax Codes window.

Setting up suppliers and products
Before you start to set up suppliers, ensure that you have a complete list of all the suppliers 
used by the shops. 

To set up a supplier

CAUTION : Keep data consistent with RetailManager It is important to keep supplier details 
consistent with RetailManager. You cannot send supplier updates to shops through RetailEnterprise.

1 Go to the Information menu and choose Suppliers. The Suppliers window appears.
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2 Go to the File menu and choose New (or press F5 or CTRL+N). The Supplier Information 
<New > window appears.

If the Supplier No./description already exists! message appears, you have 
entered a supplier number or description that already exists in the supplier database. In this 
case, you must assign a unique supplier number or description, or you can modify the 
existing supplier.

3 Click Commit to save the supplier details.

4 If you want to set up another supplier, go to step 2 above.

5 Click Close to close the Suppliers window.

To set up a product

In the RetailEnterprise Central product database, each product must have a unique identity 
based on the bar code. For example, it is possible to have two or more products with the same 
department, categories and description, as long as they have a different bar code. 

CAUTION : Keep data consistent with RetailManager When you are setting up products, it is 
important to use existing suppliers and tax codes that you have defined in RetailManager for the 
shops. If you don’t, the product data may be rejected when you load Centralised Updates.

NOTE : Creating departments and categories In RetailManager, you can use the Departments & 
Categories Assistant to create departments and categories. This assistant is not available in 
RetailEnterprise. If you want to use the departments and categories you have defined in 
RetailManager in RetailEnterprise, you will need to either enter them into RetailEnterprise Central 
manually, or import them from RetailManager. For more information on exporting stock information 
from your RetailManager shopfront, see ‘To export data from a RetailManager shopfront’ on 
page 87. For more information on importing stock information into RetailEnterprise Central, see ‘To 
import data into RetailEnterprise Central’ on page 91.

Supplier No. Enter a supplier number of your choice.
You can enter a supplier number that contains letters or numbers or a combination 
of both.This can be up to six characters long, for example, ‘ABC100’.

Name Enter the name of the supplier. This name can be up to 15 characters long.
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1 Go to the Information menu and choose Products. The Products window appears.

 

2 Go to the File menu and choose New (or press F5 or CTRL+N). 

The Product Information <New> window appears.

Bar code Enter a unique product code of your choice. You can enter product codes 
that contain letters or numbers or a combination of letters and numbers. For 
example, you can enter a product code of ‘CD0120’.

Department Select the relevant department for the product. If the department doesn’t 
exist, type a new department.

Category 1, 2 and 3 Select the relevant categories for the product. If a category doesn’t exist, 
type a new category.

Description Enter the description of the product. This description can be up to 40 
characters long and must be unique for the bar code entered above.

Extended 
Description

Enter a longer description of the product, if required.

Freight Item If the product is a freight item, select this option.

Static Quantity If sales of the product should not reduce the stock level in the shops, select 
this option. 
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If the This bar code already exists! message appears, you have entered a product 
with a bar code that already exists in the product database. In this case, you must assign a 
unique bar code, or you can modify the existing product.

3 Click Commit to save the product details.

4 If you want to set up another product, go to step 2 on page 36.

5 Click Close to close the Products window.

Allow Fractional 
Quantities

If your shops can buy or sell partial quantities of the product, select this 
option.

Track Serial 
Number

If you want the shops to track the serial number of the product, select this 
option.

Unit of Measure Select the relevant unit of measure for the product.

Tax code – Purchase Select the tax type charged when purchasing this product from the supplier.

Price Inc – Purchase Enter the purchase price of the product, inclusive of tax if applicable.

Tax code – Sell Select the tax type charged when selling this product.

Price Inc – Sell Enter the selling price of the product, inclusive of tax if applicable.

Custom 1 Enter or select an additional method of grouping the product that is specific 
to your business, if required.

Custom 2 Enter or select an additional method of grouping the product that is specific 
to your business, if required.

Supplier Select the supplier for the product.

Threshold Qty Enter the minimum stock level below which the product should be 
reordered.

Holding Enter the standard quantity to reorder for this product.
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Setting up regions and shops
Before setting up your shops you must set up the regions to group the shops by. This is a 
geographical grouping, so before starting you need to consider the areas of your business and 
plan how to group your shops. If you are a small retail business, you can create a single region 
and assign all your shops to it.

The table below provides some different examples of how regions can be set up.

To set up a region

To create details of a region in RetailEnterprise Central, perform the following steps:

1 Go to the Information menu and choose Regions. The Regions window appears.

If you operate in... you might set up a region 
for each...

for example

More than one 
state/island

State/island you operate in [Australia] NSW, QLD, ACT
[New Zealand] North, South

Different areas or 
towns of the same 
state/island 

Area or town of the state/island 
you operate in

[Australia] Gold Coast, Sunshine Coast, 
Rockhampton
[New Zealand] Otago, Marlborough, 
Auckland, Taranaki

Only one area Metropolitan area or 
suburb/city you operate in

[Hong Kong, Malaysia and Singapore] 
North western, Central, Eastern
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2 Go to the File menu and choose New (or press F5 or CTRL+N). The Region Information 
<New> window appears.

If the Code/Description/Collection Sequence already exists! message 
appears, you have entered a region code, description or collection sequence that already 
exists in the region database. In this case, you must assign a unique region code, 
description or collection sequence, or you can modify an existing region.

3 Click Commit to save the region details.

4 If you want to set up another region, go to step 2 above.

5 Click Close to close the Regions window.

Code Enter a region code of your choice. You can enter a region code (up to six 
characters) that contains letters or numbers or a combination of both.

Description Enter the description or name of the region.

Summary Start 
Time

Enter or select the start time for each shop in this region to create the 
summary information file for later collection. 
To ensure that this time is actually set in the shops, you have to dispatch the 
instruction to the shops for this region (see ‘Manually transferring messages 
and updates’ on page 65).
Specify a time before the Collection Time set up in the Settings window (see 
‘To specify your RetailEnterprise Central settings’ on page 30).

Collection 
Sequence

Enter the sequence number of the region. This is the sequence in which 
regions are processed when collecting summary information.
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To set up a shop

NOTE : Set up regions first A shop exists in a region, therefore, you must set up a region before 
you can add a shop to it.

1 Go to the Information menu and choose Shops. The Shops window appears.

2 Go to the File menu and choose New (or press F5 or CTRL+N). The Shop Information 
window appears. 

If you have not created any regions an error message appears. You will need to go back and 
create a region before you create a shop (see ‘To set up a region’ on page 38).

The Shop Information window has a header area which displays the number, name and 
region of the shop you have selected or are creating. 

Shop No The shop number is allocated automatically.

Shop Name Enter the name of the shop.

Region Select the required region from the list.
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The four tabs contain information about the shop:
General—the address and contact details of the shop
Connection—how you communicate with the shop (modem, email, etc.).
Transfer—what data you send to and collect from the shop
Audit—the history of transfers between the shop and your central office (generated 
automatically by RetailEnterprise Central).

General tab The General tab contains the contact details for the shop and is divided into 
two areas: Address Details and Contact Details.

Connection tab The Connection tab allows you to nominate the method of 
communicating with the shop. You cannot communicate with a shop or test its connection 
without this information.

Address Details

• Address Enter the street address of the shop. To enter a new line, press SHIFT+ENTER.

• Postal Address Enter the postal address of the shop.

Contact Details

• Contact Enter the name of the primary contact for the shop.

• Phone Enter the area code and phone number for the shop.

• Fax Enter the area code and fax number for the shop.

Dial-up

• Modem Phone No. Enter the area code and phone number for the modem connected to your shop 
computer containing the RetailManager database.

• Computer Name Enter the computer name for the shop. If there is more than one RetailManager 
computer at the shop, enter the name of the computer where RetailEnterprise 
Shop is installed.

• User Name Enter the user name used for logging on.

• Password Enter the password used for logging on. This is displayed as a string of asterisks.

LAN/WAN
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Transfer tab The Transfer tab allows you to specify the inbound and outbound data 
required for the transfer and collection processes. The selections in the left panel determine 
the data to be collected; the right, the data to be transferred. 

• Computer Name Enter the computer name for the shop. If there is more than one computer at 
the shop, enter the name of the computer where MYOB RetailEnterprise Shop 
is installed. Click Browse to locate the computer on the network.

E-mail

• Shop E-mail 
Address

Enter the email address of the shop. 
If you have entered your email account settings in MYOB RetailEnterprise, the 
shop summary file is automatically sent when the computer goes online.
If third-party email software will be used, the shop summary file is automatically 
placed in the Outbox of the software and will be sent when the email client is 
online.

Transfer Options

Activate Data 
Transfer

If you want to activate the shop’s data transfer and collection, select this option. 

NOTE : There is a limit to the number of shops you can create when 
this option is selected (see page 43).

From Shop

• Sales Summary If you want to collect sales summary data from the shop, select this option.

• Stock Holding If you want to collect stock holding data from the shop, select this option.

To Shop

• Set Summary Start 
Time

If you want to synchronise the summary start time at the shop to the region, 
select this option.

• Product Updates If you want to send product updates to the shop, select this option.

• Messages If you want to send messages to the shop, select this option.

• Other Shops Stock 
Holdings

If you want this shop to receive stock holding information from other shops in 
your RetailEnterprise network, select this option.
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If you receive an error message during the collection process, you may be trying to collect 
summary information from more shops than are licensed.

You can create as many shops as you want with the Activate Data Transfer option deselected. 
However, there is a limit on the number of shops from which you can collect information with 
the option selected. This limit is the number of shop licences you have purchased.

When you first purchase MYOB RetailEnterprise your registration includes up to five shop 
licences—unless you purchase additional licences. In this scenario, if you later tried to collect 
information from a sixth shop with the Activate Data Transfer option selected, the above 
message appears. For more information about arranging additional shop licences, see ‘How 
do I purchase additional shop licences?’ on page 21.

Audit tab The Audit tab displays the history of transfers for the shop. You can sort the data 
in its column by clicking the small arrow at the top of the column.

By using the audit filters, you can search for information between certain dates and of a certain 
type and status. When you have set up the search, click Refresh to run the search and display 
the results. 

3 When you have completed the information in each tab, click OK to continue. 

4 If you want to set up another shop, go to step 2 on page 40.

5 Click Close to close the Shops window.

Audit Filters

• Transferred Start 
Date

Click the drop-down arrow to display a calendar. Select the start date for the 
search.

• End Date Click the drop-down arrow to display a calendar. Select the end date for the 
search.

• Status Click the drop-down arrow and nominate the status of the transfers you are 
searching for, for example, Pending, Confirmed, etc.

• Transfer Click the drop-down arrow to select whether the messages were sent to or from 
the shop.
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Testing the connection to a shop
You should test the connection to a shop when:

you create a new shop 

you change the computer connection details of an existing shop

there are problems connecting to a shop.

NOTE : Has the shop been set up for communications? You cannot successfully test the 
connection until the shop has been set up for communications as described in the MYOB 
RetailEnterprise Shop User Guide. The guide is supplied on the RetailEnterprise Central and 
RetailEnterprise Shop installation CDs.

To test the connection to a shop

1 Go to the Information menu, choose Shops, click the Connection tab and then click Test 
Connection.

If you have chosen the dial-up option, RetailEnterprise Central:
- activates your modem 
- dials up the number of the modem in the shop 
- tries to establish a connection.
If you are connected to a LAN/WAN, the process occurs automatically.
If you have chosen the e-mail option, a test message is sent to the selected shop when you 
go online. You will need to check that the shop received the test message.

2 If the test connection is successful and the message ‘Test connection to shop xxx was 
successful’ appears:
a Click OK to acknowledge the message.
b Go to step 4 below.

3 If the test connection is unsuccessful and a failure message appears, click OK to 
acknowledge the message. Take appropriate follow-up action including:

viewing the Event Log to view the sequence of events involved in the test connection as 
described in ‘To view the connection event log’ on page 82
contacting an individual shop to determine if the computer and modem are correctly 
connected.

4 Click Close to close the Shops window.
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Setting up dial-up networking between central 
office and shops

CAUTION : Dial-up networking These procedures, such as setting up user accounts and assigning 
security levels, assume a knowledge of Windows communications protocols and administrative 
functions.
It is essential that these procedures are performed correctly, so if you do not feel confident in this 
we strongly recommend that you consult an MYOB RetailManager Professional. 
However, complete information and instructions are provided in the RetailEnterprise Communications 
Setup Guide which you can access from the Help menu.

This section provides brief guidelines for setting up the communications options for 
RetailEnterprise Central in the following operating systems:

Windows Vista Ultimate

Windows XP Professional

Windows 2000.

Before you can set up communications options you must first install RetailEnterprise in your 
central office and shops. 

When you choose to use dial-up as your method of connecting between RetailEnterprise 
Central and RetailEnterprise Shop, you must set up and configure a dial-up network 
connection at your Central location, and then set up and configure a dial-up network 
connection at each of your shops.

It is essential that you complete the procedures to ensure that you benefit from the additional 
features provided by RetailEnterprise. These additional features involve connecting your 
central office to your shops using dial-up networking.

The procedures for setting up dial-up network connections vary with each version of the 
Windows operating system. 
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Before you start 
Make sure that:

your modem has been installed and configured according to the modem manufacturer’s 
instructions

you have installed and registered MYOB RetailEnterprise Central

you are logged in to your computer as an Administrator (for Windows Vista users), or as an 
Administrator or Power User (for Windows XP or 2000 users whose computers only allow 
people with administrator privileges to install programs)

NOTE : Logging into Windows Vista as a Standard user If you have the Administrator 
password, you may be able to log into Windows Vista as a Standard user. You can then set up 
dial-up networking.

you have the appropriate Windows operating system installation CD available (You might 
need your Windows installation CD to install Windows networking components.)

Setting up in Windows Vista Ultimate

NOTE : Windows Vista The steps for setting up dial-up communications may vary according to the 
edition of Windows Vista you are using. The method described here is for Windows Vista Ultimate, 
using the Classic View of the Control Panel.

Step Action Comments

1 Add RetailEnterprise 
Central as a Windows 
firewall exception

• Go to the Control Panel and double-click Security Center
• Click Windows Firewall in the left pane
• Click Allow a program through Windows Firewall
• Add RetailEnterprise Central as an exception to the firewall.

2 Create dial-up 
connection

• Go to the Control Panel and double-click Network and Sharing 
Center

• Click Set up a connection or network
• Select Connect to a workplace
• Select Dial directly
• Enter 0 as the telephone number
• Enter RMShop as the destination name
• Select the Don’t connect now; just set it up so I can connect later 

option
• Leave the user name and password blank.

3 Configure dial-up 
connection

• Go to the Control Panel and double-click Network and Sharing 
Center

• Click Manage network connections
• Right-click the RMShop network connection and click Properties
• In the General tab, delete the 0 from the phone number field.
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Setting up in Windows XP Professional

NOTE : Windows XP The steps for setting up dial-up communications may vary according to the 
edition of Windows XP you are using. The method described here is for Windows XP Professional, 
using the Classic View of the Control Panel.

Step Action Comments

1 [If you use Service 
Pack 2 or 3]
Add RetailEnterprise 
Central as a Windows 
firewall exception

• Go to the Control Panel and double-click Security Center
• Click Windows Firewall
• Add RetailEnterprise Central as an exception to the firewall.

2 Create dial-up 
connection

• Go to the Control Panel and double-click Network Connections
• Select Connect to the network at my workplace
• Select Dial-up connection
• Name the connection RMShop
• Leave the phone number blank—actual information is retrieved 

from the Central database.

3 Configure dial-up 
connection

• Go to the Control Panel and double-click Network Connections
• Right-click the RMShop dial-up connection and click Properties
• Set the RMShop Properties to:

- Leave phone number blank
- Show icon in taskbar when connected
- Accept Dialing options defaults

• Set Security to Advanced (custom settings)
- Select Allow these protocols
- Select Allow older MS-CHAP version for Windows 95 servers
- Deselect For MS-CHAP based protocols…

• Set Networking to:
- PPP: Windows 95/98/NT 4/2000, Internet
- Internet Protocol (TCP/IP)

• Set Internet Protocol (TCP/IP) properties to:
- Obtain IP address automatically
- Obtain DNS server address automatically.
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Setting up in Windows 2000

Setting up email communication between 
central office and shops

NOTE : MYOB RetailEnterprise emails In this section, the term ‘email communication’ refers to 
sending and receiving MYOB RetailEnterprise messages and updates using your email account. 
MYOB RetailEnterprise does not handle other email messages.

You can set up email communication between your central office and shops in two ways:

Using MYOB RetailEnterprise’s in-built email functionality—if you have an email 
account, you can enter your account settings directly into MYOB RetailEnterprise. MYOB 
RetailEnterprise Central will then be able to send and receive messages and updates using 
your email server. 

To use this method, you will need an email account that uses either POP or IMAP protocols. 
You will also need to find out settings such as the incoming and outgoing server addresses. 
Contact your Internet or email service provider to find out these details.

Step Action Comments

1 Specify dial-up 
networking

• Set location information:
- Enter the country code 
- Enter area code and outside line number (if necessary)
- Set dialling type

• Set Network Connection Type to Dial-up to private network
• Leave phone number blank—actual information is retrieved from 

the Central database
• Set Connection Availability to For all users
• Name the connection RMShop.

2 Configure dial-up 
connection

• Set the RMShop Properties to:
- Leave phone number blank
- Show icon in taskbar when connected
- Accept Dialing options defaults

• Set Security to Advanced (custom settings)
- Select Allow these protocols
- Select Allow older MS-CHAP version for Windows 95 servers
- Deselect For MS-CHAP based protocols…

• Set Networking to:
- PPP: Windows 95/98/NT 4/2000, Internet
- Internet Protocol (TCP/IP)

• Set Internet Protocol (TCP/IP) properties to:
- Obtain IP address automatically
- Obtain DNS server address automatically.
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Using third-party email software—if you already have separate email software set up and 
configured, you can specify that MYOB RetailEnterprise use this software for 
communication. Your email software will need to be running and your computer online for 
RetailEnterprise to be able to send and receive messages and updates.

To use this method, you will need email software that is MAPI-compliant. For example, 
software such as Microsoft Outlook, Microsoft Outlook Express, Eudora and Lotus Notes 
are MAPI-compliant. To find out whether your software is compliant, contact your software 
supplier. 

To set up email communication

To specify email settings in RetailEnterprise Central

Before you start 

Step Task See

1 In RetailEnterprise Central, specify email settings ‘To specify email settings in 
RetailEnterprise Central’ on page 50

2 In RetailEnterprise Central, enter the email 
addresses of every shop that uses email as the 
communication method

If you have not yet set up the shop, see 
‘To set up a shop’ on page 40
If you have already set up the shop, see 
‘To change an existing shop’ on page 58

3 At every shop that uses email, open RetailEnterprise 
Shop and: 
• enter the email address of the Central Office 
• specify email settings for the shop
• test the connection

The MYOB RetailEnterprise Shop User 
Guide

For this method... Check this...

[If you use Vista, or XP 
Service Pack 2 or 3]
Add RetailEnterprise Central 
as a Windows firewall 
exception

• Go to the Control Panel and double-click Security Center
• Click Windows Firewall
• [Vista users only] Click Allow a program through Windows 

Firewall
• Add RetailEnterprise Central as an exception to the firewall.

Entering your email account 
settings directly into MYOB 
RetailEnterprise

Check that you have all the information required to set up your 
account. Contact your Internet or email service provider to find out 
the following information:
• incoming server address
• outgoing server address
• your account user name and password
You should also check if any advanced settings are required. For 
example, there may be a specific port number you need to specify.
Further, if you use a dial-up connection to connect to the Internet, 
check that you have configured your connection.

Specifying third-party email 
software

Check that your software has been set up correctly and that you are 
able to send and receive emails.
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1 Ensure that your computer is online (that is, connected to the Internet). 

2 Start MYOB RetailEnterprise Central.

3 Go to the File menu and choose E-mail Settings. The E-mail Settings window appears.

4 Choose how you want to send and receive RetailEnterprise messages and updates:
If you want to enter your email settings directly into RetailEnterprise, select the Specify 
E-mail settings below option. Continue with step 5 below.
If you want to use third-party email software, select the software from the Use E-mail 
Program drop-down list. Continue with step 11 on page 51.

5 Choose whether your email account is a POP account or an IMAP account. 

6 In the RetailEnterprise Central E-mail Settings section, enter your email server addresses 
(incoming and outgoing), your email address, and your account’s username and 
password. Contact your Internet or email service provider if you do not have this 
information.

7 Click Advanced. The Advanced E-mail Settings window appears.
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8 Check if the settings in the Outgoing Server Settings and Port Settings tab need to be 
changed for your email account and make any necessary changes. 

Contact your Internet or e-mail service provider if you are unsure whether you need to 
change the default options. 

9 Click the Connection tab. Choose one of the following options:
Never dial a connection—choose this option if you are online all the time (such as in a 
broadband connection) or if you are on a LAN or WAN network. You can also choose this 
option if you do not want RetailEnterprise to automatically connect to the Internet.
Dial whenever a network connection is not present—choose this option if you use a 
dial-up connection to connect to the Internet and you would like RetailEnterprise to 
automatically dial this connection. You will need to select the dial-up networking 
connection you want to use.

NOTE : IMPORTANT: Remember to configure your dial-up connection You will need to 
configure the properties of your dial-up networking connection in Windows:
- if you want RetailEnterprise to automatically dial up, ensure that you have saved your 
username and password and have set up the connection to connect automatically.
- if you want the dial-up connection to disconnect automatically after RetailEnterprise has 
finished sending the updates and messages, you will need to specify an appropriate idle time.
For more details about configuring dial-up networking connections, consult Windows Help.

10 Click OK. The E-mail Settings window reappears.

11 Test your connection:
a Ensure that your computer is online. 
b If you chose to use third-party email software in step 4 on page 50, ensure that it is 

running.
c Click Test Connection.

A Test E-mail Settings window, similar to the one below, appears. 

12 The Test E-mail Settings window shows the status of each task: 
If all the tasks appear with a ‘Completed’ status, the test was successful. Click Close to 
close the Test E-mail Settings window. Continue with step 13 on page 52.
If one or more of the tasks have a ‘Fail’ status, the test was not successful. Click Close to 
close the Test E-mail Settings window and check that you have entered the correct 
settings in the E-mail Settings window. Or, if you’re using third-party email software, 
ensure that your email software is configured correctly and is running. 
Then, repeat the test (step 11 above) until you achieve a successful connection.
S E T T I N G  U P  E M A I L  C O M M U N I C A T I O N  B E T W E E N  C E N T R A L  O F F I C E  A N D  S H O P S   5 1



5 2   
NOTE : Anti-virus software may block the connection If you are using anti-virus software, 
the test connection may fail because it is blocking the connection. You will need to change 
the anti-virus software settings to allow connections by RetailEnterprise.

13 In the E-mail Settings window, click OK.

Where to from here? Now that you have entered your email settings in RetailEnterprise 
Central, you will also need to complete the following steps:

In RetailEnterprise Central, enter the email addresses for every shop that uses email as the 
communication method. If you have not yet set up the shop, see ‘To set up a shop’ on 
page 40. Or, if you have already set up the shop, see ‘To change an existing shop’ on 
page 58.

At every shop that uses email, open RetailEnterprise Shop and enter the email address of 
the Central Office. You will also need to specify the email settings for the shop and test the 
connection. For more details, see your MYOB RetailEnterprise Shop User Guide.
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3  Using 
RetailEnterprise 
Central 

This chapter describes how you use MYOB RetailEnterprise Central on the computer installed 
in your central office, typically the head office of your organisation.

You can use RetailEnterprise Central to monitor, manage and report on the daily point-of-sale 
processing in RetailManager on your shop terminals.

Maintaining product details

This section describes how you maintain details of products used at the shops, using MYOB 
RetailEnterprise Central. 

It is important to understand that the RetailEnterprise Central product database may not be an 
exact mirror of the RetailManager stock database in each shop. This may be so for a number of 
reasons including:

whether it is your company’s policy to maintain prices centrally, or allow shops to set their 
own prices and margins

the functionality that allows each shop to either accept or reject your centralised updates

the possibility that each shop will have stock items that are specific to the shop.

NOTE : Maintaining consistent databases We recommend that, as far as possible, you try to 
keep your product database consistent with the stock items in your shops. Otherwise, the data 
you collect from the shops may become difficult to reconcile.

Product updates RetailEnterprise Central generates automatic product updates whenever 
you make changes to product details.You can also create a manual product update by 
specifying a list of products that you want to send to shops (see ‘To manually create a product 
update’ on page 55).

Once the updates are created or generated, RetailEnterprise Central assigns them to be 
transferred as part of the scheduled collection process (see ‘Collection process’ on page 68). 
You can also transfer the updates manually (see ‘Manually transferring messages and updates’ 
on page 65). 
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To change product details

NOTE : Creating a product For instructions on how to create a product in RetailEnterprise Central, 
see ‘To set up a product’ on page 35. 

1 Go to the Information menu and choose Products. The Products window appears. If 
there are many products displayed, scroll until you see the required product.

TIP : Searching for a product To quickly find the product you are looking for in a long list, 
click the column heading to sort that column alphabetically. Click in the column and then type 
the first letter of the item you are looking for, for example, ‘C’. The first item beginning with ‘C’ 
is highlighted. Continue to scroll until you find the required product.

2 Select the product you want to change.

3 Go to the File menu and choose Open (or double-click the product). The Product 
Information <Edit> window appears.

4 Make the necessary changes to the product details.

5 Click Commit to save the changed product details. The Products window reappears.

6 If you need to change another product, repeat step 2 to step 5.

7 When you have finished changing product details, click Close to close the Products 
window.

NOTE : Sending product updates to shops RetailEnterprise Central will generate a product 
update and send it to the shop as part of the collection process. If you want to create an update 
and transfer it manually, see ‘To manually create a product update’ on page 55.
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To manually create a product update

1 Go to the Create menu and choose Product Update Transfers. The Product Update 
Transfers window appears.

The Product Update Transfer List area shows the list of updates, both the updates 
generated automatically and those created manually. The Product Update Transfer 
History area shows the shops that this update has been assigned to, along with the 
transfer status of the update.

2 Go to the File menu and choose New (or press CTRL+N). The Product Update Details 
window appears.

3 If required, change the Description of the update from the default (‘Product list’).

4 In the Product Items List area, select the products that you want to include in this update. 
If you want to include all the listed products, click the Include column heading.
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5 To filter the list of products by department, categories, custom fields or supplier:
a Click Filter List. The Filter List window appears. 

If you want to filter by custom fields, select the Show Custom Values option. If you want 
to filter by supplier, select the Show Suppliers option.

b By default, all the departments, categories, custom fields and suppliers are selected. 
Clear the checkbox next to any criteria that you do not want to filter by.

c When you have specified your criteria, click OK. The Message Details window 
reappears with the list of products that match the criteria.

6 In the Assign to Shop(s) area, select the shops that you want to send this message to.

7 Click Save. The update is saved and the Product Update Transfers window reappears.

A message number is allocated to the update and the update status is set to Pending for 
each of the shops.

8 To create another message, repeat step 2 to step 7. 

9 To transfer the update:
a In the Product Update Transfers window, select the updates you want to transfer and 

click Send Now. 

NOTE : Unable to select updates? You cannot select automatically generated updates or 
updates that have a status of Sent or Confirmed. 

If there are messages waiting to be transferred, a message appears asking if you want to 
include them in the transfer. To include the messages in the transfer, click Yes. Or, if you 
only want to transfer the product updates, click No.
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The Send Now window appears, with the shops for this transfer grouped by region. You 
can click the plus sign next to the region name to see the list of shops. If you want to 
exclude a shop from the transfer, clear the checkbox next to it.

b Click Start to begin the transfer. The progress of the transfer is displayed in the Shop 
Connection Event Log area.
If you need to halt the process at any time, click Stop.

c When the transfer is complete, click Close to close the Send Now window.

Maintaining shop details

You must create and maintain details of every shop from which you want to collect summary 
information of sales and stock data. Apart from the shop name and address, the key details you 
must specify are the computer connection details and summary collection information 
options.

Unless the computer connection details are complete and correct for a shop, the collection 
process will not work and you will not collect information from the shop. 

You need to specify summary collection information options to indicate whether to collect 
from a shop, what to collect—sales summary or stock holding or both—and whether a shop 
can receive stock holding information from other shops.

For instructions on how to create a new shop in RetailEnterprise Central, see ‘To set up a shop’ 
on page 40.
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To change an existing shop

To change details of an existing shop, perform the following steps:

1 Go to the Information menu and choose Shops. The Shops window appears. 

2 Select the shop you want to edit. If there are many shops displayed, scroll until you can see 
the required shop.

3 Go to the File menu and choose Open (or double-click the shop). The Shop Information 
window appears.

4 Make the necessary changes to the shop details. See ‘To set up a shop’ on page 40 for 
more information about shop details.

5 Click Commit to save the changed shop details.

6 If you need to change another shop, repeat step 2 to step 5.

7 Click Close to close the Shops window.
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Maintaining supplier details

You must create and maintain details of a supplier for every product in the product database of 
RetailEnterprise Central. For instructions on how to create a new supplier in RetailEnterprise 
Central, see ‘To set up a supplier’ on page 34.

CAUTION : Keep data consistent with RetailManager It is important to keep supplier details 
consistent with RetailManager. You cannot send supplier updates to shops through RetailEnterprise.

To change an existing supplier

To change details of an existing suppler in RetailEnterprise Central, perform the following 
steps:

1 Go to the Information menu and choose Suppliers. The Suppliers window appears.

2 Select the supplier you want to edit. If there are many suppliers displayed, scroll until you 
can see the required supplier.

TIP : Searching for a supplier To quickly find the supplier you are looking for in a long list, 
click the column heading to sort that column alphabetically. Click in the column and then type 
the first letter of the supplier you are looking for, for example, ‘C’. The first item beginning with 
‘C’ is highlighted. Continue to scroll to the required supplier.

3 Go to the File menu and choose Open (or double-click the supplier you want to edit). The 
Supplier Information <Edit> window appears.

4 Make the necessary changes to the supplier details.

5 Click Commit to save the changed supplier details.

6 If you need to change another supplier, repeat step 3 to step 5.

7 Click Close to close the Suppliers window.
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Maintaining region details

You can define regions to group your shops by area or location. For example, you may choose 
to define a region for each State.

When you create a region you can specify a collection sequence for the region. The collection 
sequence is used by the collection process to determine the order for dialling into the shops in 
that region. For more information, see ‘Collecting summary information from shops’ on 
page 67.

For instructions on how to create a new region in RetailEnterprise Central, see ‘To set up a 
region’ on page 38.

To change an existing region

To change details of an existing region in RetailEnterprise Central, perform the following steps:

1 Go to the Information menu and choose Regions. The Regions window appears.

2 Select the region you want to edit. If there are many regions displayed, scroll until you can 
see the required region.

3 Go to the File menu and choose Open (or double-click the region). The Region 
Information <Edit> window appears.

4 Make the necessary changes to the region details.

NOTE : Summary Start Time This is the time when MYOB RetailEnterprise Shop creates the 
summary information file of sales and stock data for each shop in the region.

5 Click Commit to save the changed region details.

6 If you need to change another region, go to step 2 above.

7 Click Close to close the Regions window.
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Sending messages to shops

This section describes how to create and send new messages to shops from the central office 
using MYOB RetailEnterprise Central. After creating messages, RetailEnterprise Central 
provides the flexibility for you to choose which messages to send to which shops.

In addition to the messages you create, there are some standard instructions which you need 
to send to the shops regularly. You use these standard instructions to set the start time for the 
collection process and to forward product updates to the shops.

When you are dispatching these combined bulletins of messages and instructions, you have 
the option to select which instructions and messages to dispatch to which shops. 

To create a new message

1 Go to the Create menu and choose Messages. The Messages window appears.

The window is divided into two areas: Message List and Message History. It shows the list 
of messages and for each message, the related job and the shops it was sent to.

TIP : Reading a message You can double-click a message to display it.
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2 Go to the File menu and choose New (or press CTRL+N). The Message Details window 
appears.

3 Click Save. A message number is allocated to the message.

After saving, the message status is set to Pending and the Inactive option and Delete 
button are enabled. 

4 Click Close to close the Message Details window. The new message is added to the 
Message List area of the Messages window. 

5 To create another message, go to step 2 above.

6 Click Close to close the Messages window. The messages (except those that are inactive) 
are sent during the next collection process. If you want to manually transfer the messages, 
see ‘Manually transferring messages and updates’ on page 65.

Message Header

• Message No. This is set by RetailEnterprise Central.

• Created Date This is set by RetailEnterprise Central.

• Subject Enter the subject line of the new message. For example, ‘Price increase for 
packaged products’.

• Inactive If you do not want to send the message now, select this option. Selecting this 
will hide the message in the message list.

Message Enter the body of the message. To enter text on a new line, press ENTER.

Assign to Shop(s) Select the shops that you want to send this message to.
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Making copies of messages
You can make a copy of a message. Copies are useful if you need to send a message again, or 
if you want to use an existing message as the basis for a new one.

To make a copy of an existing message

1 Go to the Create menu and choose Messages. The Messages window appears.

The Message List area shows all the messages that have been created; the Message 
History area shows the job number of the highlighted message and the shops it was sent 
to or is waiting to be sent to.

2 From the Message List, select the message you want to copy.

3 Double-click the message or go to the File menu and choose Open. The Message Details 
window appears.

4 Click Copy. A copy of the message appears. The subject and the message content are the 
same as in the original message.
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5 If required, change the subject or message content.

6 In the Assign to Shop(s) area, select the shops that you want to send this message to.

7 Click Save. A message number is allocated to the message. After saving, the message 
status is set to Pending and the Inactive option and Delete button are enabled. 

8 Click Close to close the Message Details window. The new message is added to the 
Message List area. 

9 Click Close to close the Messages window. The messages are sent during the next 
collection process (unless the message is inactive). If you want to manually transfer the 
messages, see ‘Manually transferring messages and updates’ on page 65.

To delete a message

The Messages Details window enables you to delete pending messages.

NOTE : No deletion of Confirmed or Sent messages You cannot delete a message that has the 
status Confirmed or Sent.

1 Go to the Create menu and choose Messages. The Messages window appears.

The Message List area shows all the messages that have been created; the Message 
History area shows the job number of the highlighted message and the shops it was sent 
to or is waiting to be sent to.

2 To delete a message:
a From the message list, select the message you want to delete. 
b Double-click the message or go to the File menu and choose Open. The Message 

Details window appears.
c Click Delete. A confirmation message appears.

d Click Yes to confirm.

3 Click Close to close the Messages window.
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Manually transferring messages and updates

There may be times when you need to send a message or an update to a shop other than at 
the appointed transfer and collection time. You can use the Manual Transfer window to do 
this. 

Manual Transfer window

Shop Selection This area displays a list of shops organised by region. You can use the list to 
specify the regions, shops and data that will form part of the transfer. 

Viewing items
You can click the plus signs to expand the list and click the minus signs to 
collapse the list.
• To view a list of shops—click the plus sign next to a region to see the list of 

shops in the region.
• To view the kinds of transfers—click on the plus sign next to a shop to see 

the transfers grouped in From Shop (from shops to the central office) or To 
Shop (from the central office to the shop).

• To see the data included in the transfer—click on the plus sign next to 
From Shop or To Shop to see the types of information in the transfer. For 
example, you may be collecting Sales Summary and Stock Holding Levels 
from the shop, and you may be sending Messages and Products to the shop.
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Transferring messages and updates

To transfer messages and updates

1 Go to the Transfers menu and choose Manual Transfer. The Manual Transfer window 
appears.

Including or excluding items
A tick next to an item (whether it is a shop, a region or specific data) indicates 
that it is included in the transfer. By default, all items will be ticked when you 
first open the window.
• To include an item—expand the list so you can see the item and then tick 

the checkbox next to it (if it isn’t ticked already). Any items grouped under 
this item are also ticked. So, if you tick the checkbox next to a region, all the 
shops in the region will also be included. 

• To exclude an item—expand the list so you can see the item and then clear 
the checkbox next to it. Any items grouped under it are also cleared. So, if 
you clear the checkbox next to a region, all the shops in the region will be 
excluded.

Shop Connection 
Event Log

Displays the progress of the transfer.

Connection Status Displays the summary of the transfer.

Start button Click this button to start the transfer.

Stop button Click this button to stop the transfer.

Close button Click this button to close the window.
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2 In the Shop Selection list, specify the following:
The regions or shops that will receive the information—tick the checkbox next to the 
region or shop that you want to include in the transfer, and clear the checkbox next to 
those you want to exclude.
For each selected shop, the kind of data transfer (From Shop or To Shop)—for example, 
if you only want to send data, you can clear the checkbox next to From Shop.
For each selected shop, the specific data you want to transfer—expand the To shop list 
and clear the checkboxes next to the data you want to exclude. For example, if you do not 
want to send Messages, you can clear the checkbox next to it.

For instructions about how to select items in this window, see ‘Manual Transfer window’ on 
page 65.

3 Click Start (located below the Connection Status area) to begin the transfer and 
collection process. The progress of the transfer is displayed in the Shop Connection Event 
Log area.

If you need to halt the process at any time, click Stop.

4 When the transfer is complete, click Close to close the Manual Transfer window.

Collecting summary information from shops

One of the key functions of MYOB RetailEnterprise Central is to enable your business to collect 
summary information from your shops. 

In order to do this, you must first specify the unique communication details of the 
RetailManager computer at each shop. You then have to set up these details in RetailEnterprise 
Central on the central computer—see ‘Setting up your Central database’ on page 32.

During the collection process, the central office computer uses these communication details to 
connect to each shop in sequence. After establishing a connection between the central 
computer and the RetailManager computer in the shop, the process collects the summarised 
sales and stock data. The process stores the sales and stock data in the RetailEnterprise Central 
database on the central computer for further processing. 

If you are using Stock At Other Shops to pass information to the shops in your RetailEnterprise 
network, Central recontacts your shops and passes this information when the collection 
process is complete.
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About Central–Shop communications
MYOB RetailEnterprise Central provides three methods of communication:

Dial-up The dial-up method is explained in detail in this manual. At a preset time, central 
office dials up each shop in turn and collects the summary information file. Central can also 
send messages and other information such as sales summaries, price updates and 
administrative information.

For information on setting up dial-up communications, see ‘Setting up dial-up networking 
between central office and shops’ on page 45.

LAN/WAN The local or wide area network (LAN/WAN) method may be used by large 
enterprises with a distributed computer network that, typically, would have a computer 
administrator or other professional to oversee the system. In this case, information is gathered 
automatically with little or no intervention by the staff at your central office or shops. At a 
preset time, your central office collects the summary information file from each shop in turn 
but this happens automatically through the network communications of the LAN or WAN, 
rather than dialling up each shop. Central and shop can also send sales summaries, price 
updates and administrative information to each other.

Contact your system administrator for information about setting up or using your network.

Email The email method is useful for smaller enterprises. To enable your central office and 
each shop to communicate directly, you can enter your e-mail account settings into MYOB 
RetailEnterprise. Messages between the central office and shop will be sent when these offices 
are online using their POP or IMAP email account. 

Alternatively, if you already have separate email software set up and configured, you can 
specify that MYOB RetailEnterprise use this software for communication. Your email software 
will need to be running and your computer online for RetailEnterprise to be able to send and 
receive messages and updates. 

For information on setting up email communication, see ‘Setting up email communication 
between central office and shops’ on page 49.

Collection process

When the collection process runs

Normally, the process is scheduled to be run automatically at a set time, usually at night, 
following each business day. 

However, if there is a failure during the overnight collection for any reason, the process can be 
run manually at any time. For example, if a remote computer at one of the shops was not 
available or online, the collection process would not be completed for that site. 

For more details of the procedures involved, see ‘To start the collection process manually’ on 
page 70.
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How the collection process works

The collection process involves the following sequence of automated activities:

1 Transfer any sales and stock data from previously incomplete collections.

2 Establish a list of all shops to be dialled in sequence based on the dial sequence set up in the 
Region record (each shop is assigned to a region).

3 Take the following action for each shop in the list:
a Dial up or connect to the shop.
b Send any messages and instructions pending for the shop.
c Establish a connection to the directory that contains the summary information for the 

shop (usually the same folder where MYOB RetailEnterprise Shop is installed).
d Check that the summary information data is ready for collection.
e Download the summary information data to a temporary database on the central 

computer. 
f If the download is successful, transfer the downloaded data to the permanent database 

in RetailEnterprise Central.
g If the connection fails, the process makes retry attempts if you specified a retry count 

when setting up RetailEnterprise Central.

4 Record all events and errors that occur during the collection process, including the result of 
each dial-up connection in the event log file.

5 If you are using Stock At Other Shops, RetailEnterprise Central will then:
a Connect to each shop in the list of shops that has had a successful download.
b Send Stock At Other Shops information to each shop in the list.

After the collection process has finished

On the following business day, the relevant person in your central office should check the 
results of the overnight collection process in RetailEnterprise Central. This involves reviewing 
the event log files created by the collection process on the central computer. If these log files 
show that any of the collection sessions failed, the relevant person must take the appropriate 
action. For more information, see ‘Viewing the connection event log’ on page 81.

After collection is completed, you can use the RetailEnterprise Central functionality to manage 
and analyse the data, and also produce comprehensive reports—as described in the following 
sections of this chapter.

NOTE : Before starting You may want to notify the shops involved that you are about to start the 
process to ensure that they have their modem and phone lines ready for when RetailEnterprise 
Central starts connecting to the shops. You can do this either by phone or fax, or by sending a new 
message as described in ‘Sending messages to shops’ on page 61.
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To start the collection process manually

1 Go to the Transfers menu and choose Manual Transfer. The Manual Transfer window 
appears.

2 In the Shop Selection list, specify the following:
The regions or shops that you want to receive information from—tick the checkbox next 
to the region or shop that you want to include in the transfer, and clear the checkbox next 
to those you want to exclude.
For each selected shop, the kind of data transfer (From Shop or To Shop)—for example, 
if you only want to collect data, you can clear the checkbox next to To Shop.
For each selected shop, the specific data you want to transfer—expand the From Shop list 
and clear the checkboxes next to the data you want to exclude. For example, if you do not 
want to collect Stock Holding Levels, you can clear the checkbox next to it. For more 
information about this window, see ‘Manual Transfer window’ on page 65.

3 Click Start to begin the collection process.The progress of the transfer is displayed in the 
Shop Connection Event Log area.

If you need to halt the process at any time, click Stop.

4 When the transfer is complete, click Close to close the Manual Transfer window.
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Viewing the history of transfers to and from shops
The Transfer Audit function allows you to view the history of communications and transfers to 
and from shops.

To view the history of transfers to and from shops

1 Go to the Transfers menu and choose Transfer Audit. The Transfer Audit window 
appears.

Audit Filters

• Shop Click in the field and press F2 or click the drop-down arrow to display the Search 
for Shops window. Select the shop and click OK.

• Transfer Start 
Date

Click the drop-down arrow to display a calendar. Select the date for the 
beginning of your search.

• End Date Click the drop-down arrow to display a calendar. Select the date for the end of 
your search.

• Message 
Type

Click the drop-down arrow to nominate the type of messages you are searching 
for. You can choose from the following message types, or choose (All).
• SAS—Sales Summary
• STL—Stock Holding Levels
• STC—Product Updates
• MSG—Messages
• OSL—Other Shop Stock Levels
• SHP—Shops
• SUP—Supplier Updates
• LST—Product Lists
• SST—Set Summary Start Time.

• Status Click the drop-down arrow to nominate the status of the messages you are 
searching for, for example, Pending, Confirmed, etc.
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2 Click Refresh to apply your search criteria. The results are displayed in the grid.

3 If the audit indicates that there were some connections that were unsuccessful, you should 
find the cause by:

checking the event log—see ‘To view the connection event log’ on page 82.
checking the computer connection details for your shop—see ‘To test the connection to 
a shop’ on page 44.
contacting an individual shop to determine if the computer and modem are correctly 
connected.

4 Click Close to close the Transfer Audit window.

Setting up pricing

Bulk price updates
Bulk price updates enable you to apply a price adjustment to multiple stock items. You select 
the stock items by department and categories, then apply price updates either as a new price 
or as an adjustment to the current price. 

You can apply bulk price adjustments either as a percentage of expected gross profit or as a 
dollar value.

If you want to make changes to other stock item details such as bar code, description or 
quantity held, see ‘Updating stock item details’ in the MYOB RetailManager User Guide for more 
information. You cannot change quantities in RetailEnterprise Central.

To apply bulk price updates

1 Go to the Product Management menu and choose Bulk Price Updates. The Bulk Price 
Updates window appears.
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2 In the Stock Filters group, select the department and categories of the required stock 
items.

3 Click Load. 

The stock items that match the selected department and categories are displayed. Ensure 
the items selected are the items to which you want to make updates before you proceed.

4 If you want to adjust your prices by a dollar value:
a In the Bulk Price Adjustments group, click By Selling Price.

If you want to add or subtract an amount to or from the current price (for example, 
you might want to add $2.00 to each stock item), select the Adjust from current 
value option. 
If you want to assign a new price (for example, you might want to price all listed stock 
at $10.00) deselect the Adjust from current value option.

b In the Adjustment Value field, enter the value that you either want to apply as an 
adjustment or as a price.

5 If you want to adjust your prices by expected gross profit (eGP%):
a In the Bulk Price Adjustments group, click By eGP% Margin.

If you want to adjust the current margin, select the Adjust from current value 
option. 
If you want to assign a new margin, deselect the Adjust from current value option.

b In the Adjustment Value field, enter the value that you either want to apply as a new 
margin or as an adjustment.

6 Click Update. The updated prices appear.

7 Check the results of your pricing adjustments to ensure they are correct.

NOTE : Adjusting a price or margin for a single stock item Click either the Sell Inc or eGP% 
column of a selected stock item line in the MYOB RetailManager Bulk Price Updates window 
and enter the adjustment.

8 Click Commit and then click Yes to the confirmation message.

9 Click OK in the report window and then Close to close the Bulk Price Updates window.

The results of your pricing adjustments are saved to the RetailManager stock database.

10 Click Close to close the Bulk Price Updates window.

To send the bulk pricing update to shops

The new pricing information will be transmitted to shops at the next automatic connection for 
data transfer and collection if you have already set up the shops to receive this information. 
See ‘To set up a shop’ on page 40 or ‘To change an existing shop’ on page 58 for instructions 
on setting up a shop to receive pricing information.

However, you may want to send this new information immediately.
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1 Go to the Transfers menu and choose Manual Transfer. The Manual Transfer window 
appears.

2 In the Shop Selection list, specify the following:
The regions or shops that will receive the information—tick the checkbox next to the 
region or shop that you want to include in the transfer, and clear the checkbox next to 
those you want to exclude.s
For each selected shop, the kind of data transfer (From Shop or To Shop)—for example, 
if you only want to send data, you can clear the checkbox next to From Shop.
For each selected shop, the specific data you want to transfer—expand the To shop list 
and clear the checkboxes next to the data you want to exclude. For example, if you do not 
want to send Messages, you can clear the checkbox next to it.

For more information see ‘Manual Transfer window’ on page 65.

3 Click Start to begin the transfer process.The progress of the transfer is displayed in the 
Shop Connection Event Log area.

If you need to halt the process at any time, click Stop.

4 When the transfer is complete, click Close to close the Manual Transfer window.
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Generating reports

In MYOB RetailEnterprise there are a number of standard reports that are accessed by 
choosing Reporting from the Tools menu. 

Note that all the reports in RetailEnterprise are based only on current data and do not include 
data that has been archived. For more information about archiving, see ‘To archive 
non-current data’ on page 86. 

NOTE : Previewing and printing a report First make sure that you have a printer installed and set 
up for A4  paper. Make this your default printer. RetailEnterprise will only print to the default printer 
for your computer. 

Go to the Tools menu and choose Reporting. The Reports Index window appears.

Report filters
Report filters give you control over the content of your reports. When you select a report filter 
button, the filter window displayed enables you to refine the information displayed on the 
report. If a filter button is shaded (as shown in the illustration above), it is not applicable to the 
current report. 

Report filter buttonsReports

Print and Preview 
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These report filters are:

Date(s) filter Enter the date range for the report in the Start and End fields. You can click 
Assist to select a date using the Date Selection window in both of these fields.

Selection filter This filter is not available in RetailEnterprise.

Custom filter Select the Custom fields by which you want to report.

Group By filter Select how you want to group or separate the information in the report. 
The report will display subtotals for each group you have defined in this filter. Select None if 
you don't want to group your items with subtotals.

Categories filter Select whether to report for a single product department or all 
departments. Select a department from the drop-down list, or select All to include all 
departments in the report. You can also select categories you want to include in the report. 
Click the checkbox next to the category you want to display, or click Select All to include all 
categories in the report.

Sort By filter Choose how you want the report results to be sorted—there are a number of 
options, including bar code, categories and supplier. Select an option from the list box, and 
then choose the Descending Order option if required. You can also choose a secondary sort 
order option if there is more than one item with the same Primary Sort value. For example, two 
items with the same bar code can be sorted by Cost.

Optional filter Select whether to include products with zero sales or not. This filter is only 
available in the What’s Selling sales report.

Ranges filter Enter a maximum and minimum value for the number of sales. This filter is 
only available in the What’s Selling sales report.

Wildcard filter Enter a wildcard to find a character pattern, for example, D* to find all 
customers whose name begins with the letter ‘D’. This filter is only available in the What’s in 
Stock product report.

Shops filter Select the shops that you want to include in the report. Click Select All to 
include all shops in the report, or tick the checkbox of the specific shops you want to include.

Suppliers filter Select the suppliers that you want to include in the report. Click Select All 
to include all suppliers in the report, or tick the checkbox of the specific suppliers you want to 
include.

Print and Preview

These buttons enable you to preview and print the report you have selected. Before you print 
a report it is a good idea to preview the report to confirm that the details are as you expect. For 
example, check that you have used the report filters to select the correct dates and sort by 
fields.

NOTE : Previewing reports You need to have an A4 printer driver installed in your computer to be 
able to view a report on screen. 

Selecting Preview multiple reports enables multiple reports to be open for viewing 
simultaneously.
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Report categories 

Sales reports

There are two sales reports:

The Sales Summary report lists sales and profit margins for each of the shops, and 
summary figures for all shops. You can specify the following report filters:

Dates
Shops.

The What’s Selling report lists all items sold in the chosen period and displays the available 
quantity, number of sales, cost price and stock value. You can specify the following report 
filters:

Dates
Custom
Group By
Categories
Sort By
Optional 
Ranges
Shops
Suppliers.

Product reports

There are two product reports: Product Listing and What’s in Stock. You can specify the 
following report filters:

Custom

Group By

Categories

Sort By

Optional

Wildcard

Suppliers.

Supplier reports

There are two supplier reports:

The What Needs Ordering report is a summary of products that require ordering based 
on their threshold quantities. For each product that needs ordering, the report shows the 
available amount, current order and back order quantity. You can specify the following 
report filters:

Custom
Group By
Categories
Sort By
Shops
Suppliers.
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The What’s On Order report is a summary of products that have been ordered but not 
received. For each product on order, the report shows the order quantity, back order 
quantity and total quantity. You can specify the following report filters:

Custom
Categories
Sort By
Shops
Suppliers.

Miscellaneous reports

There is one miscellaneous report—the Connection Event Logs report. This report provides a 
record of the events that occurred whenever RetailEnterprise Central connected to the shops. 
You can specify the following report filters:

Dates

Shops.

To generate a report

1 Go the Tools menu and choose Reporting. The Reports Index window appears.

2 Select the type of report you want. For example, click Sales to display all the Sales reports.

3 Select the individual report from the list of reports. For example, click What’s Selling. This 
activates the report filter options for the report.

4 To specify the report filters you require:
a Click the report filter button—for example, click the Group By filter.
b Select the filters. 
c Repeat this step for each report filter option you need.
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5 To display the report using the Report Viewer window, click Preview. 

For more information about the Report Viewer, see ‘Using the Report Viewer’ below.

The information contained in the report depends on the filters you selected. You may need 
to vary the filter selections until you obtain the information you want.

Using the Report Viewer
When you preview a report in MYOB RetailEnterprise Central, the separate Report Viewer 
window is opened. 

You can use the Report Viewer window to:

view a report

search for text in a report

print a report 

export a report. 

To view a report

Zoom in on a displayed report by selecting a zoom percentage ( ) at the top of the 
window.

Use the left and right arrows (  ) to move between pages in the report.

Use the first page arrow ( ) to go to the first page of the report and the last page 
arrow ( ) to go to the last page of the report. 
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To search for text in a report

The MYOB RetailEnterprise report viewer has text search capability. To search for a value such 
as a name, amount or date in a displayed report:

1 Click the search icon ( ) to display the Search window.

2 In the Find what field, enter the text you are searching for.

NOTE : Search text When entering text in the search field, you can enter either the whole text 
or part of it. 

3 Click Find Next. RetailEnterprise will search for the first occurrence of the search text and 
display a frame around it. Clicking Find Next again will move the frame to the next 
occurrence of the search text. 

To print a report

In MYOB RetailEnterprise, reports are printed on standard A4-size paper. 

1 Click the print icon ( ). The Print window appears. 

2 Specify the page range, required number of copies, etc. and click OK.

The report is printed to your report printer. 

To export a report

You can export an MYOB RetailEnterprise Central report to several word processor and 
spreadsheet formats, such as Microsoft Word and Microsoft Excel, as well as to HTML, ODBC 
and common data interchange formats such as text and rich text. 

You can save a report to disk or have it open directly in an application. Reports can also be 
made available to other users through Lotus Notes and Microsoft Outlook if you have these 
programs installed on your computer.

1 Click the export icon ( ). The following window appears. 
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2 Specify the format of the report by making a selection from the Format drop-down list. 

NOTE : Report format When you export a report, you will be prompted for formatting details, 
depending on the report format you specified.

3 Specify the destination of the report by making a selection from the Destination 
drop-down list. If you select:

Application, the report will be saved to a temporary file and then opened in the 
appropriate application.
Disk file, you can save the report on your hard drive in the location you specify or to an 
external storage device such as a USB storage device or external hard drive.
Lotus Notes Database, you can list the report in the Lotus Notes Desktop from where 
other users can access it. 
Microsoft Mail (MAPI), you can email the report as an attachment in the format you 
specified.
Exchange folder, you can export your report to an exchange folder in the format you 
specified. 

4 Once you have selected your destination and format, click OK.

To exit the Report Viewer

You can exit the Reports window by clicking the close icon ( ) in the upper-right corner of 
the Reports window. 

Viewing the connection event log

This section describes how you view the connection event log that MYOB RetailEnterprise 
Central maintains. The connection event log provides a record of the events that occurred 
whenever RetailEnterprise Central connected to the shops.

This is especially useful for checking the results of the automated collection process in 
RetailEnterprise Central. After the process has collected summary information of sales and 
stock data from your shops, you need to verify if the process has been successful. 

During the collection process, RetailEnterprise Central makes a connection to a shop and 
records the details of each connection in the event log file on your computer. Normally, the 
process should finish successfully but occasionally there may be errors or problems with the 
process. 

Reviewing the collection process includes the following tasks:

checking results of the collection process by viewing the connection event log or 
generating the Connection Event Logs report

following up on any problems or errors in the connection event log

starting the collection process manually, if necessary.
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To view the connection event log

To view the details in the connection event log file, perform the following steps:

1 Go to the Tools menu and choose Connection Event Logs. The Connection Event Logs 
window appears.

2 Choose the shop that you want to view the log for.

3 Specify the date range—typically yesterday’s and today’s date if you are checking for last 
night’s processing.

To change the range of dates displayed:
a In the Start Date field, click the arrow and select the required start date from the 

calendar list.
b In the End Date field, click the arrow and select the required end date from the calendar 

list.

4 Click Refresh to view the event log details for the new date range.

5 Check that the information seems correct. If you notice that there are no connections to a 
certain shop or some other discrepancy, you will need to check the connection set up. This 
may include any or all of the following:

checking the computer connection details for a shop as described in ‘Testing the 
connection to a shop’ on page 44
contacting the individual shop to determine if the computer and modem are correctly 
connected.

6 Click Close to close the Connection Event Logs window.
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Printing a connection event log report
There are two ways to print a connection event log report. You can print from the Connection 
Event Logs window or from the Reports Index window.

To print from the Connection Event Logs window

1 Generate the connection event log as in the previous procedure.

2 To preview the report before printing:
a Go to the File menu and choose Print Preview. The Report Viewer appears.
b Click the print icon ( ) in the Report Viewer and then click OK to print the report.
c Click the close icon ( ) to close the Report Viewer.
d Click Close to close the Connection Event Logs window.

3 To print the report without previewing:
a Go to the File menu and choose Print.
b Click OK and then OK again.
c Click Close to close the Connection Event Logs window.

To print from the Reports Index window

1 Go to the Tools menu and choose Reporting. The Reports Index window appears.

2 Click Misc and then click Connection Event Logs.

3 Specify the Date(s) and Shops report filters.

4 To preview the report before printing:
a Click Preview. The Report Viewer appears.
b Click the print icon ( ) in the Report Viewer and then click OK to print the report.
c Click the close icon ( ) to close the Report Viewer.
d Click the close icon ( ) to close the Reports Index window.

5 To print the report without previewing:
a Click Print to print the report.
b Click the close icon ( ) to close the Reports Index window.

NOTE : The Connection Event Logs report will not include logs pertaining to RetailEnterprise 
Central (for example, RE Central started on PC028N). You can view these logs in the 
Connection Event Logs window.
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4  Administration

This chapter includes the following tasks:

managing your Central database

changing your settings

archiving non-current data from your Central database

importing and exporting data.

Managing your Central database

It is important to safeguard your Central database by backing it up regularly. Depending on 
your business activity, this could be daily. The more regular your backups, the less data you 
may lose if there is a problem with either your computer or the database file.

To back up your Central database

1 Go to the File menu and choose Settings. The Settings window appears.

2 If required, change the backup location in the Backup Path field.

Click Browse to select the path from the Open window.

3 Click Backup. The Save As window appears. 

4 Enter the name for the backup file or accept the suggested name (which is based on the 
date). You can also change the location of the file—either browse to the new location or 
type in the entire path (e:\Backups\RME060429).

5 Click Save to perform the backup and close the Settings window. A confirmation message 
appears.

6 Click OK.

RetailEnterprise Central makes a zipped, backup copy of your Central database in the 
location specified in the Backup Path field. The zipped file contains:
RMCentral.mdb
RMCentralArchive.mdb

Storing your backup data We recommend you store your backup files on removable media 
such as an external hard drive or a CD, and preferably at another physical location. If your PC 
fails or there is a fire for example, it’s no use to have the back up on your c:\ drive or on a disk 
on your desk.
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To restore your Central database

If you need to restore your Central database in RetailEnterprise Central, use your most recent 
backup file. 

Note that RetailEnterprise Central must not be running a process on your central computer 
while you are restoring your database.

NOTE : Reenter information after restore You will need to reenter any transaction information 
that has occurred since you created your backup databases.

1 Go to the File menu and choose Settings. The Settings window appears.

2 Click Restore. The Select File to Restore window appears.

3 Select the backup file you want to restore. 

4 Click Open. RetailEnterprise Central restores the database. 

A message informing that the database was successfully restored appears.

5 Click OK.

Archiving non-current data

This section describes how to perform housekeeping in MYOB RetailEnterprise Central on your 
central computer. 

To archive non-current data

You have the option to start an archive manually.

1 Go to the File menu and choose Settings. The Settings window appears.

2 If required, change the count in the Archive data more than x days old field.

3 Click Archive Now. The following message appears:

4 If you want to continue archiving all data created before the date shown, click Yes.

Otherwise, click No.

NOTE : Archived data not included in reports Non-current data is retained in a separate 
archive database and is not included in reports you generate from now on.

5 When the Archive complete! message appears, click OK. 
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Setting up your Central database from a 
RetailManager shopfront

Using the MYOB RetailEnterprise Import and Export Wizard, you can import and export 
information about suppliers and stock items from a RetailManager shopfront into your 
RetailEnterprise Central database. You might want to do this when you are setting up the 
central office database for the first time. Exporting and importing between databases is quite 
simple. 

For more information on importing and exporting, refer to the Administration chapter of the 
MYOB RetailManager User Guide.

To export data from a RetailManager shopfront

RetailEnterprise Central can import supplier and stock data from your RetailManager shopfront 
database. 

NOTE : Export/import sequence The order in which you export and import files is important. 
Always export and import the supplier.txt file first so that the correct relationship between supplier 
and stock items is maintained in the database. 

First, export supplier information

1 Go to the File menu and choose Import & Export.

If you have an open shopfront you will be asked to close the connection to your shopfront 
and back up your database. 

2 If you want to proceed without backing up, click Continue. 

Or, if you want to back up your database, click Backup. In the window that appears, 
choose a location for the backup file and click Save.

The shopfront connection is closed, and the 
MYOB RetailManager Import & Export Wizard window appears.
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3 Click Export Data and click Next. The Export Database Selection window appears, 
showing the database from which data will be exported.

If you are running the Export wizard for a second consecutive time or if no database is 
displayed, you may need to specify the database:
a Click Browse. The Select Database window appears.
b Open the required shopfront database folder, select the recent.mdb file and click 

Open. The name of the database file you selected is displayed.

4 Click Next. The Export Table Selection window appears.

5 Select Supplier from the Select a table to export list.
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6 Click Next. The Export Viewer window appears, listing the fields that will be included in 
the export.

7 Click Export. The Save table as window appears.

8 Specify the location and file name for the export:
a Specify the folder in which you want to save the export data file.
b Type the name for the file in the Filename text box, or use the default name supplied.
c Use the Save as type drop-down list to select the format in which you want to save the 

exported data. 
d Click Save. 

A message appears indicating that the export was successful.

9 Click Export Again to run the wizard again.

Next, export stock information

10 Click Export Data and click Next. The Export Database Selection window appears, 
showing the database from which data will be exported.

If you are running the Export wizard for a second consecutive time or if no database is 
displayed, you may need to specify the database:
a Click Browse. The Select Database window appears.
b Open the required shopfront database folder, select the recent.mdb file and click 

Open. The name of the database file you selected is displayed.
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11 Click Next. The Export Table Selection window appears.

12 Select Stock from the Select a table to export list.

NOTE : Stock table If you select to export Stock table information, you have the option to 
export a subset of your stock information. Select specific stock information using the Supplier, 
Custom Field 1, Custom Field 2, Department, Category 1, Category 2 and Category 3 fields. 
You set these fields using the RetailManager Stock window. If you wish to export the entire Stock 
table, leave all other fields as <All>.
You can also specify whether you want to export the cost and sell prices as Tax Exclusive or Tax 
Inclusive by selecting either of these options.

13 Click Next. The Export Viewer window appears, listing the fields that will be included in 
the export.

14 Click Export. The Save table as window appears.

15 Specify the location and file name for the export:
a Specify the folder in which you want to save the export data file.
b Type the name for the file in the Filename text box, or use the default name supplied.
c Use the Save as type drop-down list to select the format in which you want to save the 

exported data. 
d Click Save. 

A message appears indicating that the export was successful.

16 Click Finish. The MYOB RetailManager Import & Export Wizard window closes. Close 
RetailManager.
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To import data into RetailEnterprise Central

First, import supplier information

1 Start RetailEnterprise Central if it is not already running.

2 Go to the File menu and choose Import & Export. The Welcome to the MYOB 
RetailManager Import & Export Wizard window appears.

3 Click Import Data and click Next. The Data Selection window appears.

4 Specify the file you want to import data from:
a Click Browse next to the Import file from field. The Locate File window appears.
b Locate and select the file you want to import, and click Open. The name of the text file 

you selected is displayed.
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5 Click Next. The Import File Options window appears.

6 Select the Supplier option.

7 Specify if the first line (or record) in the import file contains a Label or actual Data. In most 
cases the first record in an import text file is a label, and not actual import data.

8 Determine and select the type of field separator—Comma or Tab—used in the import file. 
Switching between the comma and tab options will cause the grid on the right to display 
a list of field names. If you select the wrong format, the grid will only have one field name 
appearing on one line. If this happens, simply select the other format.

NOTE : Field Separator A separator is the character used to separate one field element from 
another in a text file record.

9 Click Next. You will need to specify whether to Add or Update records. Click Add if you 
are creating new records or Update if you are updating an existing database. 
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10 When you have finished setting the import options, click Next. The Field Matching 
window appears.

11 Click Match all by name and then click Import. 

A message similar to the following appears.

12 Click Import Again.
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Next, import stock information

13 Click Import Data and click Next. The Data Selection window appears.

14 Specify the file you want to import data from:
a Click Browse next to the Import file from field. The Locate File window appears.
b Locate and select the file you want to import, and click Open. The name of the text file 

you selected is displayed.

15 Click Next. The Import File Options window appears.

16 Select the Stock option.

17 Specify if the first line (or record) in the import file contains a Label or actual Data. In most 
cases the first record in an import text file is a label, and not actual import data.

18 Determine and select the type of field separator—Comma or Tab—used in the import file. 
Switching between the comma and tab options will cause the grid on the right to display 
a list of field names. If you select the wrong format, the grid will only have one field name 
appearing on one line. If this happens, simply select the other format.

NOTE : Field Separator A separator is the character used to separate one field element from 
another in a text file record.
C H A P T E R  4 A D M I N I S T R A T I O N



19 Click Next. You will need to specify whether to Add or Update records. Click Add if you 
are creating new records or Update if you are updating an existing database. 

20 Click Next. The Field Matching window appears.

21 Click Match all by name and then click Import. A message similar to the following 
appears.

22 Click Finish. The MYOB RetailManager Import & Export Wizard window closes.
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Appendix A:
Troubleshooting
This chapter describes solutions to a variety of the problems you may encounter while using 
RetailEnterprise Central. Not all these problems are caused directly by RetailEnterprise Central, 
and not all the solutions involve fixes within the product.

The following areas are described in this chapter:

Troubleshooting tips for common problems

Problems with maintenance 

Problems with the Data Capture process.

TIP : Keep a record of problems For your own purposes, as well as forother users or 
employees, it is well worth making a note of the problem, any possible contributing factors, 
steps and events leading up to the problem, who fixed the problem and the solution.

Troubleshooting a problem requires careful attention to the circumstances that may have 
contributed to the problem. If MYOB RetailEnterprise Central is not working correctly, consider 
the following:

When did you first notice the problem?

What were you doing in RetailEnterprise Central at the time?

Was anything happening that might have affected your computer (such as electrical 
repairs in your building, street or community)?

Did the problem arise when you were trying to upgrade the system by installing new 
hardware or software?

Can you recreate the problem (by repeating a pattern of events)?

Who has been using RetailEnterprise Central? Is it only the authorised employees?

Have this information handy when you call technical support.
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Troubleshooting tips for common problems

This section includes useful troubleshooting tips for some common problems that can affect 
your computer. 

For example, you may notice that the computer seems to slow down when you are using 
MYOB RetailEnterprise Central. Although this problem is experienced while using 
RetailEnterprise Central, it is not necessarily caused by it. The problem may be caused by 
another component or application in your Windows environment.

Before calling for expert and possibly, expensive help, there are a number of tips you can try. 
These tips are not specific to RetailEnterprise Central, but they have been tried and tested to 
resolve some common problems in Windows.

These troubleshooting tips are listed below:

Restart your computer and printers. Click Start, choose Shut Down, and then choose 
Shut Down. After your computer has shut down, turn off the computer and any printers. 
Then take the following action:
a Wait 30 seconds.
b Turn on the printers.
c Turn on and restart your computer.
d Restart RetailEnterprise Central.

Check your hard disk using Disk Cleanup. Click Start, choose Programs, Accessories, 
System Tools, and choose Disk Cleanup. See Windows Help for more information.

Defragment your hard disk. Click Start, choose Programs, Accessories, System Tools, 
and choose Disk Defragmenter. See Windows Help for more information.

Delete the files in your temp folder. Use Windows Explorer to go to your temporary 
folder (usually c:\WINDOWS\Temp) and delete all the files in it. Make sure there are no 
other programs running in the background when you do this.

Check your computer for viruses. To do this you will need a virus checker program. 
Check with your retailer.

Maintain your database. If you are having problems with your database, see ‘Managing 
your Central database’ on page 85 for more information about managing your database, 
and what options are available for fixing it.

After you have tried one or more of the fixes listed above, restart your computer. If the problem 
still occurs, contact your MYOB RetailManager Professional or technical support.
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Appendix B: MYOB 

technical support
Our technical support team can offer assistance with installing, using and troubleshooting 
MYOB RetailEnterprise Central. However, support cannot be provided on issues arising from 
hardware or operating system faults, or incompatible hardware or software. You may need to 
contact an MYOB RetailManager Professional if these issues arise.

Technical support options for your region

Prepare before you call technical support

Gather information about the problem

Try to recall and write down details of the problem, including what you did before the 
problem occurred, and the exact text of any error message that appeared. See if you can 
reproduce the problem.

Gather the following information about your software

The serial number, which is printed on the RetailEnterprise Central CD sleeve or 
registration form. To check this in the software, go to the Help menu and select Company 
Details.

The version of the software, which is printed on the RetailEnterprise Central CD sleeve. To 
check this in the software, go to the Help menu and select About MYOB RetailEnterprise.

If you’re in... See...

Australia page 100

New Zealand page 102

Hong Kong page 103

Malaysia page 104

Singapore page 105
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Gather the following information about your computer

Your computer type, processor and model, and the version number of the operating 
system you are running. To locate this information, do the following:

Australia

Technical support phone numbers and charges

If you are using... do this...

Windows Vista 1 Go to the Start menu.

2 Right-click Computer and choose Properties. The System window 
displays the hardware and operating system details.

Windows XP or 
2000

1 Right-click the My Computer desktop icon.

2 Choose Properties and then click the General tab. The System 
Properties window displays the hardware and operating system details.

Support Plan Phone number Available times (EST) Charges

Retail Enhancement 
and Support

1300 555 115 9.00am to 7.00pm
(Monday to Wednesday)
9.00am to 9.00pm
(Thursday to Friday)
9.00am to 5.00pm 
(Saturday to Sunday)

 Local call charges

Pay-Per-Call Support
If your introductory 
support period has 
expired and you are 
not subscribed to Retail 
Enhancement and 
Support.

1300 555 128 9.00am to 7.00pm
(Monday to Friday)

Local call charges and 
Pay-Per-Call charges. 
To find out what our 
current Pay-Per-Call 
charges are, call 
1300 555 115.
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Technical support options

Retail Enhancement and Support

Maintaining your Retail Enhancement and Support subscription provides you with:

technical support seven days a week

all upgrades and updates we release for your product

regular communications including Coverage, or monthly e-newsletter

exclusive discounts and special offers.

On expiry of your initial subscription, the Retail Enhancement and Support subscription can be 
renewed at your expense.

For the terms and conditions of Retail Enhancement and Support, visit myob.com.au/retail 
and click MYOB RetailEnterprise. From the Quick Links section on the right side of the page, 
click Support plans for businesses and then click MYOB Retail Enhancement and Support.

Pay-Per-Call support

If you do not renew your Retail Enhancement and Support subscription, you can access 
technical support on a Pay-Per-Call basis. Pay-Per-Call support is charged at a per-minute rate 
and a minimum charge applies. Prices and conditions are subject to change without notice 
and are available from MYOB by calling 1300 555 115.

Support notes

You can access a wide range of technical support notes at myob.com.au/supportnotes

Keep up to date with RetailEnterprise on the Web

The MYOB website (myob.com.au/retail) is updated frequently and contains the latest 
RetailEnterprise information, news, and links to many useful resources.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.
A U S T R A L I A   1 0 1
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New Zealand

Technical support phone numbers and charges

Technical support options

BusinesSUPPORT

Maintaining your businesSUPPORT subscription provides you with:

Automatic software upgrades—automatically upgrade to a new version of your MYOB 
RetailManager product when it is released during the course of your subscription, keeping 
your business up to date with the latest retail business management technology.

Quarterly issues of MYOB InFocus—a year’s subscription to the quarterly publication 
written by MYOB Technical Communications specialists, providing you with tips and 
techniques to help you get the most out of your retail business management and 
accounting system.

0508 number access to MYOB technical support—telephone a technical support 
specialist for advice about your MYOB RetailManager software.

Email access to MYOB technical support—email a concise and accurate description of 
your technical issue to the technical support email address. MYOB will usually reply by the 
next business day.

Fax access to MYOB technical support—fax a concise and accurate description of your 
technical issue to the technical support address. MYOB will usually reply by the next 
business day.

Notification of and access to regularly-updated web-based MYOB support 
notes—combine an up-to-date subscription with an up-to-date email address to receive 
notice of the latest software support information online.

For the terms and conditions of businesSUPPORT, visit myob.co.nz, click Support, then click 
Business Owners and then click Join MYOB businesSUPPORT.

Support notes

You can access a wide range of technical support notes at myobnz.custhelp.com

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

RetailManager 
businesSUPPORT

By subscription only

0508 123 123 9.00am to 5.00pm
(Monday to Wednesday),
9.00am to 9.00pm
(Thursday and Friday) and
11.00am to 5.00pm
(Saturday and Sunday)

Calls are free when 
subscription is paid. 
(Subscription fee can 
only be paid via direct 
debit.)
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Hong Kong

Technical support phone numbers and charges

Technical support options

Retail Enhancement and Support

Maintaining your Retail Enhancement and Support subscription provides you with:
priority telephone technical support five days a week
fax and email technical support, with an answer by the next business day
all upgrades and updates we release for your product
exclusive discounts and special offers.

The purchase price of your MYOB RetailManager software includes one year’s subscription to 
Retail Enhancement and Support.

When your initial subscription to Retail Enhancement and Support expires, you can renew 
your subscription if you want.

NOTE : Your subscription to Retail Enhancement and Support starts from the date you register 
MYOB RetailManager.

Support notes 

You can access a wide range of technical support notes online.

1 Go to the MYOB website at myob.com.hk

2 Click the Support tab.

3 In the Business Management products section, click 
Support Notes and Advanced Academy.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

Retail Enhancement 
and Support

(852) 3402 9888 9.30am to 6.00pm 
(Monday to Friday)

For information about 
call charges, contact 
technical support.
H O N G  K O N G   1 0 3
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Malaysia

Technical support phone numbers and charges

Technical support options

MYOB Business Support

Maintaining your MYOB Business Support subscription provides you with:
priority telephone technical support five days a week
fax and email technical support, with an answer by the next business day
all upgrades and updates we release for your product
exclusive discounts and special offers.

The purchase price of your MYOB RetailManager software includes three months’ subscription 
to MYOB Introductory Support.

When your initial subscription to MYOB Introductory Support expires, you can subscribe to 
MYOB Business Support if you want.

NOTE : Your subscription to MYOB Introductory Support starts from the date you register MYOB 
RetailManager.

Support notes 

You can access a wide range of technical support notes online.

1 Go to the MYOB website at myob.com.my

2 Click the Support tab.

3 In the For Businesses section, click Technical Support Notes.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

MYOB Business 
Support

(603) 8991 0188 or 
1300 88 6962 (The 
latter number is for 
customers outside 
the Klang Valley 
region. Calls to this 
number are charged 
at the local call rate.)

9.00am to 5.30pm 
(Monday to Friday)

For information about 
call charges, contact 
technical support.
A P P E N D I X  B : M Y O B  T E C H N I C A L  S U P P O R T
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Singapore

Technical support phone numbers and charges

Technical support options

MYOB Business Support

Maintaining your MYOB Business Support subscription provides you with:
priority telephone technical support five days a week
fax and email technical support, with an answer by the next business day
all upgrades and updates we release for your product
exclusive discounts and special offers.

The purchase price of your MYOB RetailManager software includes three months’ subscription 
to MYOB Introductory Support.

When your initial subscription to MYOB Introductory Support expires, you can subscribe to 
MYOB Business Support if you want.

NOTE : Your subscription to MYOB Introductory Support starts from the date you register MYOB 
RetailManager.

Support notes 

You can access a wide range of technical support notes online.

1 Go to the MYOB website at myob.com.sg

2 Click the Support tab.

3 In the For Businesses section, click Technical Support Notes.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

MYOB Business 
Support

(65) 6505 6584 9.00am to 5.30pm 
(Monday to Friday)

For information about 
call charges, contact 
technical support.
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MYOB training options

MYOB RetailManager Professionals

NOTE : In this document, MYOB Point of Sale Specialists [New Zealand], MYOB POS Partners 
[Hong Kong] and MYOB Professional Partners [Malaysia and Singapore] are referred to as MYOB 
RetailManager Professionals.

MYOB RetailManager Professionals provide independent on-site assistance with MYOB 
RetailEnterprise and associated products and services, including:

Retail business system needs and analysis

RetailEnterprise installation, setup and implementation 

Point-of-sale hardware and peripheral solutions

On-site training and support for RetailEnterprise

RetailEnterprise database maintenance

Integration with MYOB business management software.

As independent businesses, MYOB RetailManager Professionals offer a range of services.

For more information or a list of MYOB RetailManager Professionals, go to myob.com, choose 
the link for your region and click Partners.

MYOB training and MYOB Approved Training Providers

NOTE : MYOB training is not available in Hong Kong.

If you want to know more about the new features in MYOB RetailManager or how 
RetailManager can improve the profitability of your retail business, enrol in an MYOB 
RetailManager course. An MYOB RetailManager course will show you how to set up your 
system correctly from the start, and how to use RetailManager’s many features to help you 
improve your store’s sales performance. You’ll be trained using the latest version of 
RetailManager by MYOB professional trainers.

[Australia only] In addition to an MYOB RetailManager training course, independent 
classroom-based training is available through our network of MYOB Approved Training 
Providers. 

For more information about your training options, go to myob.com, choose the link for your 
region and click Training + Events.
A P P E N D I X  B : M Y O B  T E C H N I C A L  S U P P O R T
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